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C
ES is a royal flush of nerd-tastic 

gadgets and gear—but most of 

it isn’t exactly tailored to Apple 

fans. You can see everything from TVs 

to washing machines to flashlights in the 

grand halls of the Las Vegas Convention 

Center. That’s why we spent most of our 

time in the Apple-centric iLounge, which 

doubled in size since last year. When the 

dust settled (and our AT&T service bars 

finally reappeared), we distilled everything 

we’d seen down to these favorites. 

By far, the majority of Apple-related 

gear at CES was for iPhones and iPads. 

So when we saw Mac stuff, we took 

notice. By far, the majority of Apple-

related gear at CES was for iPhones 

and iPads. So when we saw Mac stuff, 

we took notice. One of our jackpot finds 

was Mobee’s Magic Charger ($49.90, 

mobeetechnology.com), a nifty and 

utilitarian induction charger for the Magic 

Mouse. You place the custom battery 

pack inside your Magic Mouse, rest it on 

the included charging pad, and it charges 

wirelessly when you’re not using it. And 

it looks rad, as does our other favorite 

Maccessory, the H-Squared Mini mount 

($49.95, store.h-sq.com), which was 

designed in conjunction with Apple’s Mac 

mini team. It replaces your mini’s cover 

with a mountable one you can screw 

right into a wall. Bonus: there’s also a 

screw pattern for VESA mounting, so 

you can attach your mini to the back of 

a VESA-compatible monitor, like, say, the 

Cinema Display. Our favorite little extra is 

an optional white LED backlight that gives 

your mounted mini some ground-effects 

t l

with. Amidst the piles of cases, plentiful 

as poker chips, we found a couple that 

deserved a shout-out. Both Speck 

(speckproducts.com) and Trtl Bot (trtlbot.

com) had sleek cases with pull-out tabs 

for stand-up viewing. Mophie brought ace 

design to its new Juice Pack Plus ($99.95, 

mophie.com), which combines a bigger, 

two-day battery with a grippy rubber 

coating. And its new iPod touch–only, 

gaming-focused Pulse case (price TBA) 

rumbles, giving you the kind of force 

feedback that you’re used to on your Xbox 

or PlayStation. 

And speaking of style, we saw more 

snazzy cases than we knew what to do 
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of force touch–only, gaming-focused Pulse 

case (price TBA) rumbles, giving you the 

kind of force feedback that you’re used to 

on your Xbox or PlayStation. 

Scosche (scosche.com) had plenty of 

cases too, but we were most impressed 

with its new heart rate monitor. The 

MyTrek attaches to your arm, instead of 

l i h t lik t diti l

y p

application, and it’ll help you get there 

with all sorts of beeps. It can also harness 

the iPhone’s built-in GPS to tell you 

how far you ran or biked and how many 

calories you burned in the process.

When we left Scosche, we could hear

CES 2011: BESt of thE BESt
We combed the gargantuan show floor to bring you the early word on this 
year’s most exciting Mac and iOS gear. BY NIC VARGUS

>>>Start
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While We Were taking the latest Macs 
for a spin for our reviews in this issue, 
in particular the 12-inch MacBook and 
13-inch MacBook Pro, something about 
Apple’s lineup of portable Macs struck 
me as a little odd, verging on annoying. 
There’s an inherent assumption that if 
you want a larger screen, you must also 
want a beast of a machine.

My own MacBook is a 15-inch Pro 
from the end of 2016. That isn’t 
because I have real need of its four 
Thunderbolt 3 ports, the most powerful 
graphics processor Apple puts in a 
portable Mac, or its Touch Bar (though 

I do like that feature). The primary reason I bought it was for a 
larger display. While testing the smaller portable Macs, I got to 
wondering how many people – office workers, in particular – 
would benefit from a more affordable 15-inch MacBook in the 
slightly smaller, thinner, and lighter body introduced in 2016.

As with the 13-inch Pro, Apple sells a “low-end” 15-inch 
model, though it costs $1,999, and is actually based on the old, 
slightly heavier design with Thunderbolt 2 ports. Even then, it’s 
a bit better specified than I have in mind.

I find it frustrating that there’s no truly affordable 15-inch 
MacBook on which I can comfortably view Numbers spreadsheets, 
work on InDesign pages, and edit photos. I doubt it’ll happen, 
but I’d love to see Apple recognize that regular office workers 
like myself, who are increasingly mobile and not near an external 
display, sometimes find even a 13-inch screen a tad too small.

From the responses we received when I talked about this 
subject in our email newsletter, some of you agree. However, 
one reader pointed out a likely reason Apple doesn’t address 
this scenario, which you can read about on the opposite page.

Speaking of our weekly email newsletter, if you’re not 
subscribed to it you can sign up at bit.ly/maclifenews to have 
your say on topics like this one. Or just email us with your 
thoughts on all things Apple at letters@maclife.com.

Big screen, Big money

alan stoneBridge, Editor

Twitter: @maclife

>>>ThE TEam

david chartier
contributor 

David has been using the 

iOS 11 beta. Find out what 

he thinks of it on page 13.

matt smith
art editor 

Matt is frantically tackling 

the new levels included in 

the recent Rider update.

ed ricketts
operations editor 

Ed’s keen for Twin Peaks 

to reach iTunes soon to 

weird himself out again.
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FacEbook: facebook.com/maclife  TwiTTEr: twitter.com/maclifeSHarE wiTH US!

Hold å after 
powering on 
your Mac to pick 
a startup disk.

I just saw the Satechi Premium USB 3.0 Hub in the 
July issue and was ready to buy one, until I went 
online and saw that the actual price was 
approaching double the price you indicated. 
My heart is broken! bob GoldEn

We’ve noticed similar situations with the prices of USB-C accessories 
being hiked by some sellers – notably toward the end of 2016, soon after 
Apple refreshed the MacBook Pro.

Rest assured, Bob, that Satechi’s Type-C Pro Hub can be bought for the 
price we quoted in our review. Were it twice the price, it’s highly unlikely 
that it would have received 4.5 out of 5 to be deemed “Excellent.” At the 
time of writing, you can get the product on Amazon – point your browser 
at bit.ly/typecprohub and you should find it for $99.99, being sold by 
Satechi and with orders fulfilled by Amazon.

We sometimes see an item pop up in search results multiple times, 
some priced exorbitantly. If in doubt, check the manufacturer’s website 
for what price an item should be. On Amazon, inspect the Other Sellers 
box, as the price initially shown may not be the most competitive.

Thunderbolt startup
I have two Thunderbolt ports on 

my 27-inch iMac, which I believe 

can run Thunderbolt 1 and 2 

devices. How do I set up a 

Thunderbolt-connected SSD 

as my Mac’s startup disk?.

Giacomo PalUcci

This is a great way to speed 

up a mac with little effort, 

though it’s costly. if you’ve 

already bought a Thunderbolt 

SSd, start by erasing it in 

disk Utility, making sure it 

has a GUid partition scheme 

and uses the mac oS 

Extended (Journaled) format.

Get the macoS installer 

from the mac app Store and 

when it asks you to choose a 

destination, pick the external 

SSd, of course. You’ll end up 

with a clean system this way.

is no longer on sale, was still 

about $100. we’ve used the 

USb 3.0 version of this $20 

option to try out macoS betas 

in the past: bit.ly/stenclosure.

bring back the 17‑inch 
macbook Pro!
In response to your newsletter: 

you’re right, there appears to be 

a low-priced 15-inch MacBook 

Pro opportunity. The question 

for all manufacturers is not 

“will people buy this,” but “will 

enough people buy this to make 

it significantly advantageous for 

us to build it?”

Apple does a ton of market 

research. Maybe their data 

suggests that the market for a 

lower-cost, 15-inch MacBook Pro 

isn’t large enough to justify its 

production. By the way, I own 

the $1,999 model – the one with 

all the old ports – and I love it!

rand blEimEiSTEr

we suspect you’re right about 

sales; that’s probably why the 

17‑inch macbook Pro was 

canned, too. Still, it breaks our 

hearts – or rather our wallets – 

that we have to spend so 

much to get a macbook that‘s 

comfortable for working on 

magazine pages on the move.

alternatively, make sure 

you have a complete backup 

in Time machine of your mac’s 

internal startup disk, start 

up in macoS recovery – hold 

ç+r at the startup sound – 

and use the Time machine 

option there to restore to the 

freshly formatted SSd. This 

will put a copy of your existing 

system on the speedy drive. 

if your mac doesn’t restart in 

the restored system, choose 

 > Startup disk, pick the 

SSd, and then restart.

if you haven’t bought a 

Thunderbolt drive already and 

your mac has USb 3, you can 

save a lot of money and still 

get good performance from a 

USb 3 enclosure with a bare 

SSd installed in it. The most 

affordable Thunderbolt 

“enclosure” we’ve used, which 

Using a higher “Looks like” setting 
squeezes more onto a Retina display.
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iPhone 8 to 
feature depth-
sensing camera
The next iPhone looks set to use 
a 3D model of your face to unlock – 
but can Apple make enough units?
BY Graham Barlow & DaviD NielD

aheaD of the predicted September 
announcement, supply-chain 
reports indicate that production of 
the components for a 3D-sensing, 
front-facing camera system in the 
new iPhone 8 is ramping up. 

3D sensors could be used in 
enhanced security and augmented 
reality apps in Apple’s next iPhone. 
The technology, which includes an 
infrared transmitting and receiving 
module, means the iPhone 8’s 
front-facing camera will be able to 
find the location and depth of objects 
placed in front of it.

With potential applications 
including face and iris recognition, 
the technology will open up a world 
of exciting new uses for the iPhone. 
As well as providing a new way to 
unlock your smartphone, the 
technology may benefit augmented 
reality – to which Apple devoted 
a lengthy segment of its WWDC 
keynote in June – by having your face 
appear as a 3D model in apps and 

FEED YOUR MIND. FEAST YOUR EYES.

START
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Feed your mind. Feast your eyes.

ioS 11 beta hints 
at livestreaming
Soon you may be able to broadcast 
your screen BY Parker wilhelm & alaN StoNeBriDGe

QuietlY meNtioNeD on one 

of Apple’s WWDC keynote slides 

for iOS 11 was “Screen recording.” 

The idea of recording an iPhone 

or iPad’s screen isn’t new, of 

course; you’ve been able to do 

it for years by using a USB cable 

to connect a device to QuickTime 

on a Mac, for example. What the 

slide referred to is iOS 11’s ability 

to record its display contents 

to its own storage, without the 

involvement of hardware other 

than the device you’re using.

It now seems Apple’s ambitions 

for this capability extend beyond 

recording the display for later 

editing – in an app like iMovie, 

say. The Next Web reports that 

a “Start Broadcast” button has 

been spotted in one of the 

developer betas of iOS 11.

While the button doesn’t seem 

to actually broadcast at the time 

of writing – pressing it currently 

starts the plain screen-recording 

feature – it’s being speculated 

that it will allow for livestreaming 

of your phone’s screen.

Right now there has been no 

confirmation from Apple about 

the Start Broadcast button’s 

purpose — or whether it will 

definitely be available in the 

publicly released version of 

iOS 11 that’s scheduled for this 

fall — but if this really is a new 

way to stream from a mobile 

device, we can see why Apple 

would jump on the opportunity.

User-broadcast video streams 

have become incredibly popular 

over the last few years, with 

YouTube and Facebook Live 

becoming major destinations 

for watching feeds. Meanwhile, 

Amazon’s streaming service, 

Twitch, recently updated its 

mobile app to allow broadcasting. 

There’s huge potential in a 

livestreaming feature being 

available system-wide in iOS, 

without app developers having 

to implement it in each app.

games. It’s thought the 3D sensors 
will only be included in the iPhone’s 
forward-facing camera system, 
however, probably for cost reasons.

the korea heralD, usually a fairly 
reliable source of insider info from 
Apple’s supply chain, says Apple has 
started buying and leasing its own 
manufacturing equipment in a bid 
to make sure it has enough phone 
parts to keep up with expected 
demand for the next-gen iPhone. 
The Herald says the machinery is 
responsible for making rigid-flex 
printed circuit boards (bit.ly/rfpcbs).

The move to buy the equipment, 
costing tens of millions of dollars, 
is apparently part of a bid to help 
Apple’s remaining suppliers deal 
with complicated production 
challenges and schedules.

This talk adds more fuel to the 
rumor that the iPhone 8 is going to 
be delayed, or at least available in 
very limited quantities when it 
launches this fall. Still, it sounds like 
a raft of bleeding-edge features will 
make it worth the wait; in addition 
to face recognition, the iPhone 8 
is said to incorporate a 5.8-inch, 
edge-to-edge display with a 
fingerprint reader under it, extra 
augmented reality features in the 
camera, and wireless charging.

The last of those features sounds 
increasingly likely given that a new 
charging sound has been found in 
the iOS 11 beta.

You can broadcast yourself using the likes of Facebook Live, and soon iOS 11 
might enable you to show off anything from your iPhone or iPad’s screen.
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App developers 
can now reply 

to your App 
Store reviews

After nine years of one-way 
feedback, you’ll finally  

know if someone’s listening 
BY PArker Wilhelm & AlAn StoneBridge

though uSer revieWS for apps 
range anywhere from helpful 
critique to angry ranting, giving 
developers a chance to step in with 
a direct response is sometimes the 
best way to let a customer feel like 
their voice is being heard.

That’s why, after what seems like 
an eternity, Apple is at last allowing 
customer support representatives to 
respond directly to user reviews on 
the App Store. Rather than having 
to find a support contact on an app’s 
website to have any hope of getting 
a response, conversations can now 
take place in the same place that 
you purchase apps.

Apple announced a few months 
ago that the feature would be 

coming to iOS and macOS, and in 
mid-July came a signal that the 

feature was imminent when 
Apple created the “Customer 

Support” role for iTunes Connect – 
Apple’s content management hub 
for developers.

By assigning that role to one of its 
staff, a company that has published 
on the App Store can now have that 
individual respond to customers’ 
reviews of its products.

Though helpful, this role seems 
long overdue – by contrast, Google’s 
Play Store for Android devices has 
allowed developers to respond to 
customer reviews since 2013.

Still, better late than never, 
as now you can field your praise – 
or, more likely, concerns or 
frustrations – without feeling like 
you’re talking to a brick wall. 

To make sure developers without 
the know-how don’t wind up in a 
PR nightmare, Apple has published  
advice on how to properly engage 
with customers in the interests of 
ensuring their satisfaction.

As a buyer of apps, it’s worth 
checking the points under the 
Reporting Concerns headline at 
apple.co/2vF8kcJ, which lists some 
code of conduct examples for 
developers and customers alike. 
Bear in mind that if a response to 
a review you’ve posted on the App 
Store is disrespectful, you can report 
your concern to Apple.

Hold a finger on a review (or 
press firmly on a device with 
3D Touch) to give feedback.
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T
his fall, millions of iOS 
devices will update to one of 
the largest changes Apple has 
ever made. Buttons will have 

moved and some muscle memory 
will get a new workout. Change can 
be hard, even frustrating at times. 
But I think in the case of iOS 11, it 
will be well worth it.

Let’s consider Control Center. 
This useful dashboard of shortcuts 
and media controls changes 
completely in iOS 11. You will be 
able to change Control Center’s 
features, and everything now fits 
on a single page in a grid of icons. 
However, unlike the Home screen, 
controls don’t have text labels to 
help you discern which is which. 
I think they’re pretty intuitive, and 
a long press (or a firm one if your 
device has 3D Touch) on many of 
them will reveal more options. 

However, I wager this will be 
quite an adjustment for many 
people. After learning my way 
around the public beta, I think it’s 
a great improvement. But be sure 
to give yourself some time to get 
used to the new layout. 

The new-look Control Center 
does double duty on iPad, as it’s 
combined with a vastly redesigned 
app switcher. Double-click the 
Home button or do a long swipe up 
from the bottom of the screen; 
Control Center will be on the right, 
with thumbnails of recent apps 

scrolling off to the left, including 
apps combined in Split View.

I consider this to be a huge 
improvement in many ways. 

Not only did Apple combine two 
somewhat related functions, it has 
made both more useful. Control 
Center is easier to navigate now 
that it isn’t spread out across 
multiple pages, and it’s easier to 
see multiple apps, including your 
Split View groups, in one place.

Still, it requires adjustment, 
especially since I’ve had to spend 
time learning Control Center’s new 
icon arrangement. Overall, though, 
I like that I don’t have to swipe 
between pages to control media 
playback. And having one place 
to go to switch apps and toggle 
settings has really grown on me.

Notification Center and the 
Lock screen also see big changes. 
In iOS 10, you can swipe left on a 
notification to reveal “View” and 
“Clear” buttons. But you can also 
swipe left on these screens to open 
the camera. It’s an interaction I’ve 
always found a little janky, as it 

was easy to trigger one when you 
wanted the other. Or it was easy 
to open a notification by accident. 

In iOS 11, you interact with 
notifications in these places with 
a long or firm press. This will show 
you the full notification text, 
interaction options (like marking 
a task complete, or sending a quick 
reply), and a close button.

This is a big change to a little 
thing we tend to do often. Some 
think the interaction feels slightly 
slower than the old method, but I 
think it also makes it clearer how 
to navigate between Notification 
Center, the Today screen, 
and Camera.

At their core, 
design decisions 
like these are 
always about 
compromise – 
what’s gained 
or lost. In the 
case of iOS 11, 
I think we’re 
gaining some 
great new 
flexibility, at 
the cost of 
spending a 
little time to 
learn a new 
way to do a few 
things. I think 
that’s a price 
worth paying.

There’s a price to pay with iOS 11, but  
it’s very much worth the initial pain, 
says david chartier 

>the shift

Be sure to give 
yourself some time 

to get used to control 
center’s new layout

All these controls are just 
one swipe away in iOS 11.
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they’re doing with machine learning.  
Artificial intelligence is in many 
ways the next big battle ground in 
tech. Nearly every major consumer 
tech company has its own digital 
assistant that gets smarter over 
time as it learns more about you. 

There are also reports AI will 
be a major feature of the iPhone 8, 
with the 10th anniversary iPhone 
including a chip dedicated to it.

Meanwhile, Apple’s journal 
underscores the emphasis on this 
subject that was evident at WWDC. 
Not only is it providing a dedicated 
home for all to see this research, it’s 
also encouraging machine learning 
researchers, students, engineers, 
and developers to reach out with 
questions and comments by emailing 
machine-learning@apple.com. 

Plus, Apple is putting its money 
where its mouth is: At the bottom 
of the page is a prominent link to 
Jobs at Apple, no doubt in the hope 
that ample AI talent will apply.

Why not use real photos to begin 
with? Apple says it’s actually cheaper 
and easier to use synthetic images 
because there’s no data labeling cost.

Researchers stand to benefit from 
this sharing of knowledge and 
findings. Hopefully the journal will 
also lead to greater public awareness 
and understanding of machine 
learning and AI, as well as what 
Apple’s doing with them. 

Apple is joining other tech giants 
in publicizing AI research for general 
readership; Google and Facebook, 
for example, often blog about what 

Apple plAced a lot of emphasis on 
its machine learning developments 
during WWDC in June, even during 
the publicly broadcast keynote. 
Now, ahead of the launch of its 
next-generation operating systems, 
which will enable developers to more 
easily use machine learning in their 
apps, it has followed up with a 
website dedicated to publicizing 
its machine learning research. 

The Apple Machine Learning 
Journal is a platform where Apple 
engineers will post about “their work 
using machine learning technologies 
to help build innovative products 
for millions of people around the 
world.” This follows last year’s 
announcement that Apple would 
begin publishing its artificial 
intelligence (AI) research.

At the time of writing there’s 
one post on the journal, “Improving 
the Realism of Synthetic Images”. 
Though published elsewhere before, 
this tweaked version provides an 
in-depth yet accessible look at 
techniques used to take images 
generated by a simulator and make 
them look more realistic. 

The goal of this is to improve 
training for machine learning 
systems based on images that, 
while made by an artificial system, 
look more like the real thing. The first post on Apple’s machine learning blog.

Get smart about 
Apple’s machine 

learning research
The iPhone maker lifts the veil on its 

progress in artificial intelligence
BY Michelle FitzsiMMons  

& AlAn stoneBridGe
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Feed your mind. Feast your eyes.

T 
his is a good time to be a 
Mac gamer. With High Sierra 
around the corner, Apple is 
making huge bets on graphics 

for its flagship operating system. 
No matter your Mac, old or new, 
High Sierra will see huge graphical 
gains with Metal 2.

The good news doesn’t stop with 
software - this year’s entire lineup 
of MacBooks was upgraded with 
Intel’s Kaby Lake processors. 
Faster processors are routine, 
but the startling numbers on 
Kaby Lake speak for themselves. 
If you’re a gamer buying a portable 
Mac, make sure you get one of the 
newest models with Kaby Lake. 

Some gamers play casual titles 
like Bejeweled 3, while others love 
immersive experiences like XCOM 
2. Here I’ll talk you through my 
opinions of Apple’s current lineup 
of Macs, and the gaming pros and 
cons of each.

Macbook This spiritual successor 
to the MacBook Air was introduced 
in 2015, and the third time is the 
charm. This year’s model boasts 
a better keyboard, more memory, 
and solid speed gains from Kaby 
Lake. But while it’s an amazing 
work machine, this MacBook still 
struggles with anything beyond 
the most basic 2D games. 
Civilization isn’t graphically 
intense, but it’s still unplayable 
on the MacBook. The good news 
is there are plenty of amazing 
2D games on macOS, one of my 
favorites being Peggle Nights. 

iMac The iMac is Apple’s best- 
selling machine for creative 
professionals, and that power 
makes it a solid game machine as 
well. But while it’s a good choice, 
there’s a lot to give gamers pause 
in the current iMac.

Apple has switched from Nvidia 
to AMD for the graphics processor. 
AMD isn’t a bad choice, but the 
processor used is not a top-of-
the-line one. Still, you should 
expect to play almost any Mac 
game from Steam on an iMac. 

Apple’s Fusion Drive technology 
is fantastic for avoiding Apple’s 
pricey SSD upgrades. These drives 

mix the high capacity of 
conventional hard disks with a 
small SSD cache for system files. 
If you play games in macOS, a 
Fusion Drive will allow for a large 
Steam library, though you don’t 
necessarily need one: bear in mind 

With new Kaby Lake Macs out now, and 
Metal 2 coming to macOS later this year, 
brianna wu considers gaming options

>gaMe loop

if you’re a gamer 
buying a portable Mac, 

get one of the new 
kaby lake models

A strong GPU helps with 
games like XCOM 2.

The iMac Pro is 
really intended for 
game developers.
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that you can tell Steam to install 
games to an external drive by 
setting up a library folder there. 
Valve’s official guide to this, at  
bit.ly/steamlib, is based on the 
Windows version, but the steps are 
essentially the same on the Mac.

Beware: if you play games in 
Windows using Boot Camp, avoid 
installing them to a Fusion Drive. 
The SSD part of the drive won’t 
work in Boot Camp, slowing 
Windows to the speed of a 
conventional hard disk.

Also worth adding: though 
currently only possible using a kit 
for developers, an HTC Vive paired 
with Apple’s External Graphics 
Development Kit may eventually 
enable you to play VR games – but 
note that the kit is unsupported in 
Boot Camp. (I find the Vive more 
comfortable and tracks much more 
precisely than the Oculus Rift.) 

Macbook pro For most gamers, 
the 15-inch MacBook Pro is your 
best option. Although a 13-inch 
model is more portable, it only 
has a dual-core processor. In the 
15-inch versions, the quad-core 
Kaby Lake processors are more 
than able to run most popular 
macOS games, including 
demanding titles such as HITMAN.

While the iMac is a better overall 
gaming machine, the portability of 
a 15-inch MacBook Pro more than 
makes up for it. In my experience, 
I play Mac games on a couch, not 
at a desk. Being able to play Dota 2 
while binging Netflix is worth the 
slight tradeoff in graphical power. 
Like the iMac, it works with 
Apple’s eGPU developer kit, so 
there’s potential for VR when the 
situation for consumer-focused 
eGPU support becomes clearer.

No matter which MacBook Pro 
you get, you’ll receive Apple’s 
blisteringly fast new generation of 
SSD storage. This will make your 
MacBook Pro double well as a 
Windows machine, where Steam 
has a deeper library. Be careful: 
Windows games do tend to run 
better - but they drain the battery 
because the software isn’t as 
tightly optimized for the hardware 
as macOS is. For intense games, 
only expect to get an hour or two 
of battery life. 

iMac pro Apple’s Space Gray beast 
doesn’t go on sale until December, 
and we won’t know its full 
capabilities until then. But, for a 
gamer looking for best-of-the-
best performance on macOS, the 
iMac Pro will undoubtedly be the 
most powerful modern computer 

Apple sells. While it will still have 
AMD graphics, the real story here 
is the minimum of eight CPU 
cores. Assuming your game is 
written to take advantage of that, 
the iMac Pro will devastate it. 

Truth be told, the iMac Pro is 
made less for gamers and more 
for game developers - but it will 
undoubtedly play games well. 
If dropping more than $5,000 on 
a gaming Mac doesn’t phase you, 
this is the one to get. 

Gamers have been neglected for 
a long time by Apple. But now, 
every Mac in the new lineup is a 
powerhouse for games - excluding 
the 12-inch MacBook. The addition 
of external GPUs may allow Macs 
to experience VR in the future. 
If you’ve been waiting tor the right 
time to invest in a new Mac, that 
wait is over.

Many entertaining 2D games, such as  
Shovel Knight, run well even on low-end Macs.
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Apple tries to make 
products that live up to 
the “it just works” mantra. 
Its devices have excellent 

interfaces, and the online support it 
offers (at support.apple.com) is second 
to none. If you’re fortunate enough to 
live near an Apple Store, you can even 
receive a free appointment at a Genius 
Bar to diagnose your troubles.

In the interests of saving you both 
time and travel expenses, though, this 
issue we’re looking at 50 of the most 
common issues with macOS and iOS, 
and presenting handy quick fixes.

Wherever possible, try to make a full 
backup of your Mac or iOS device before 
implementing these. Since we can’t 
cover every problem in depth, we have 

included links to Apple’s support site 
where possible, so you can discover 
more about your problem. Don’t forget 
you can also arrange a phone call or 
online chat with Apple Support by 
visiting getsupport.apple.com. 

Remember that all the issues listed 
here are very common, so there may 
be more than one cause behind each 
problem. A slow internet connection, 
for instance, can be due to software 
issues on the Mac or wireless 
interference. Eliminate possibilities 
before assuming that there’s a hardware 
defect with the Mac itself.

Finally, if your Apple-related 
annoyance isn’t listed here, try going 
through the online guide to isolating 
issues at apple.co/2sNQvv2. 
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Need to make a Genius 
Bar appointment? 
Maybe not. Nate Drake 
explains how you can fix 
macOS and iOS issues…

quick
50 quick fixes for macOS and iOS

&& iOS
macOS

50 quick fixes for macOS and iOS
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1 If battery life is short
Firstly, make sure that your 

software is fully updated by going to 
Settings > General > Software Update. 
Then go to Settings > Battery on your 
device to check your usage.

The easiest solution to reduce the 
drain on your battery is to go into Low 
Power Mode (in the Battery section) 
which toggles various features from one 
place – background app refresh is 
disabled, automatic downloads are too, 
visual effects are toned down, and more. 
Note that Low Power Mode is an iPhone-
only feature. Go to apple.co/2b3WUdN 
for full details. 

2 Your device is slow 
or unresponsive

If your device responds sluggishly or 
freezes, try to restart it by holding 
down both the Sleep/Wake button 
and the Home button until you see 
the Apple logo on the screen. If 
this fails to improve the situation 
and you have a recent iTunes 
or iCloud backup of your device, 
consider restoring it to factory 
settings (see apple.co/1EWim7U) 
to see if the behavior persists, 
and then restoring your backup 
to see if the problem returns. 

3 You can’t run 
a system update

Occasionally, when you go to Settings 
> General > Software Update on your 
device, the update doesn’t install. You 
can check your current iOS version in 
Settings > General > About. The easiest 
way to fix this is to connect your device 
to a Mac or PC and install the latest 
version of iTunes (apple.co/1GE4Tpx). 
Open iTunes, connect your device, and 
click the device’s icon near the top left. 
Click Summary in the left-hand pane, 
then Check For Update.

4 No sound is coming 
from your device

If you can’t hear any sound when 
receiving calls, first go to Settings > 
Sounds and make sure the Ringer and 
Alerts slider is not set to mute. Next, 
go to Settings > Do Not Disturb to 
make sure your device isn’t scheduled 
to remain silent. If these are set up 
correctly and you still can’t hear calls, 
go to Settings > Bluetooth to check if 
sound is being channelled to another 
audio device, such as a Bluetooth 
speaker. Try restarting by holding down 
both the Home and Sleep/Wake buttons.

6The red screen 
of death

If your iPhone is continuously 

power-cycling between the 

Apple logo and a solid red 

screen, you may have 

encountered the dreaded 

“red screen of death.” While 

this problem is found most 

often in the iPhone 6, it has 

occurred in other models too. 

There’s no official Apple 

Support document for this 

issue. You can try to 

perform a factory reset if 

you want, but failing this 

go to locate.apple.com to 

find your nearest Apple 

Store or Authorized 

Service Provider to have 

your device examined and, 

hopefully, fixed.

+ ios issues
Fix some of the bugbears of iOS

Make an iCloud backup before trying a fix: go 
to Settings > [Apple ID] > iCloud > iCloud Backup.

5
Your ios device 
won’t switch on

Sometimes your iOS device may appear to 

be dead and won’t respond when you try to 

use it. Usually, you just need to allow it half 

an hour to charge. If this fails, try to reset the 

device by holding both the Home and Sleep/

Wake buttons for several seconds. If the 

device still won’t turn on, connect it to a 

machine running iTunes and attempt to 

restore from your last backup.
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10Your device 
asks for the 

password for a 
different Apple ID
If someone else has signed 

into your device with 

their Apple ID, you may find 

that it asks you for their 

password. If this occurs when 

you’re using the App Store, 

tap your Apple ID at the 

bottom of the Featured page 

for an option to sign out. 

To sign out of iCloud, you’ll 

need the holder of that Apple 

ID to enter their password or 

remove the device from their 

account at iCloud.com. If this 

isn’t feasible, contact Apple 

with your proof of purchase 

for the device.

If you’ve deleted any of the apps that came built in to iOS 10, they can be reacquired through the App Store.

7 iOS device won’t charge
If your iOS device doesn’t register 

as charging when you plug it in, first 
check that you are using an official, 
Apple-certified Lightning cable – 
counterfeits are more prone to failure. 
If the battery is fully drained, make sure 
to use an Apple-certified USB plug in 
a wall socket rather than a computer’s 
USB port. If you see an alert saying your 
accessory isn’t supported, gently clean 
the Lightning port and connector with 
a dry, lint-free cloth, then restart the 
device and try charging again.

8 One of iOS’s built-in 
apps is missing

Since the release of iOS 10, Apple has 
allowed you to remove built-in apps, 
such as FaceTime and Calendar, from 
the Home screen. (Go to bit.ly/rmvapps 
for help with this.) If you can’t find a 

particular built-in app, go to the App 
Store and search for it by name, then tap 
the cloud icon to download it again. 

9 You lose your device
It’s a good idea to set up Find My 

iPhone – if you lose your iOS device, you 
can place it into Lost Mode to disable it 
the next time it connects to the internet. 
Open the Find My iPhone app on your 
device and log in with your Apple ID. 
Confirm that you wish to share your 
location. If your device then goes 
missing, use another device or computer 
to go to icloud.com and log in with your 
Apple ID. Click Find My iPhone then 
choose your device. Click Lost Mode, 
enter the lost device’s passcode and 
click Next. A message with your phone 
number appears on the device, you can 
see its location, and its ability to make 
Apple Pay payments is suspended.

50 quick fixes for macOS and iOS
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+ CoNNeCtivitY
problems

Solve some typical connection conundrums

11 Mail can’t send 
or receive emails

There are a number of reasons why Mail 
may not be able to send or receive 
messages. If this happens, try to check 
your email on another device. Sign in to 
your email provider’s webmail service 
to verify everything is okay at that end. 
Next, open Mail and choose Window > 
Connection Doctor. This tool tells 
you whether Mail is able to connect 
to the internet, and then to your 
mail server(s). Check your provider’s 
published settings match yours in 
Mail > Preferences > Accounts > 
Server Settings. 

12 Your Mac uses the 
wrong Wi-Fi network

If your Mac is near open Wi-Fi networks, 
it may connect to these rather than the 
one in your home/office. To prevent this, 
go to  > System Preferences > Network. 
Click Wi-Fi in the left-hand pane, then 
Advanced. Move your preferred wireless 
networks to the top of the list. Highlight 
any unwanted network and click the – 
(minus) button to remove it.

13 Certain apps can’t 
get online

If specific apps on your Mac are having 
trouble connecting to the internet, or 
others are having trouble connecting to 
you, you may need to modify your 
firewall settings. Your Mac’s application 
firewall is switched off by default, 
allowing all incoming connections.

First, turn on the firewall in System 
Preferences > Security and Privacy > 
Firewall. Second, click Firewall Options 
in that tab, then check whether the 
uncommunicative app is listed and 
that it isn’t erroneously set 
to be blocked.

14Your Mac doesn’t recognize its 
Magic Keyboard or Magic Mouse

If your Mac isn’t connecting to its Magic Keyboard, Magic Mouse 2, or 

Magic Trackpad 2, connect the device to your Mac using a Lightning cable. 

Go to System Preferences > Bluetooth, where you can check the device 

is charged and that it’s automatically paired. For an older input 

device, hold its power button until the LED starts 

to blink. It should appear in 

System Preferences > 

Bluetooth. Select it 

and click Pair. If the 

LED is steady, the 

device is paired.

Check your firewall 
(below) or try different 
DNS servers (right).
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15Doing things 
online has 

become slow
If browsing has slowed to 

a crawl, make sure that your 

Mac isn’t just generally slow 

(see tip 16). Try accessing the 

internet from another device 

to determine whether it’s an 

isolated issue. If the other 

device is equally slow, you 

may be experiencing wireless 

interference. Look through 

your router’s documentation 

to find out how to check and 

change the channel setting. 

If only the Mac is slow, start 

up in macOS Recovery (see 

bit.ly/macosrec) and choose 

Get Help Online to test your 

connection in the browser 

there, then contact Apple 

Support for help.

17 Your ISp is 
blocking a website

If a website is unreachable using your 
ISP, you may be able to bypass this by 
using a different DNS (Domain Name 
System) server to that offered by your 
Internet Service Provider. Go to System 
Preferences > Network and click your 
connection. Choose Advanced and go 
to the DNS tab. Click the + button to 
add new DNS servers such as Google’s 
(8.8.8.8 and 8.8.4.4), and click on the 
old DNS servers then press the – button.

18 Get super-fast Wi-Fi
If you’ve found that changing 

your aging router’s Wi-Fi channel 
doesn’t improve the speed of your 
network, and if you’ve already tried 
Apple’s recommended settings (see  
bit.ly/wifirecs), consider using a 
Time Capsule or AirPort Extreme Base 
Station, or a mesh networking system 
such as the Netgear Orbi. A Wi-Fi 
network in the 5GHz frequency band 
is much less prone to interference.  

19 You can’t connect to 
a hidden Wi-Fi network

If your router/base station broadcasts a 
hidden Wi-Fi network, you may see an 
error when trying to join it, even if 
you’re using the correct password. This 
is usually because the other network 
settings have been entered incorrectly. 
Double-check both the SSID (network 
name) and the password security type – 
WPA/WPA2 Personal, for example. 
If you’re unsure about these, contact 
your network administrator. Both 
capitalization and spaces matter, so 
make sure these are entered correctly.

20 Airplay Mirroring 
to Apple TV stutters

If you find that AirPlay Mirroring to 
an Apple TV is slow, make sure your 
router matches Apple’s recommended 
settings (bit.ly/wifirecs). Go to the 
Mac App Store’s Updates tab to ensure 
macOS is up to date, then do the same 
on your Apple TV in Settings > System > 
Software Updates > Update Software. 
If possible, try to connect your Mac 
and Apple TV to your router using 
Ethernet cables to see if that helps.

16
troubleshoot  

internet connections
If you can’t connect to the internet at all, first  

check to see if other devices on the same network 

are having the same issue. If you connect directly to 

your router using an Ethernet cable, try reseating it. 

For Wi-Fi, click the corresponding menu bar icon 

at the top right to make sure it’s enabled and that 

there’s a check mark next to your preferred  

Wi-Fi network. If you’re connected to your 

own Wi-Fi network, run Wireless  

Diagnostics for further help (see  

apple.co/29KoHJV). 

50 quick fixes for macOS and iOS
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+ App AggrAvAtioNs
Learn the best quick fixes  
for your app troubles

22 Remove “Your browser 
has been locked” alert

If your Mac’s been infected by adware, 
your browser may show the message 
“Your Apple computer has been locked,” 
preventing you from visiting other 
websites. To fix this, start up macOS in 
safe mode by holding ß at startup, then 
open Finder. Choose Go > Go to Folder, 
then type ~/Library/LaunchAgents. 
Delete any unfamiliar files from this 
folder. Do the same for /Library/Launch 
Agents and /Library/LaunchDaemons. 
In Safari, go to Safari > Preferences > 
Extensions and disable any of them you 
don’t recognize.

26Fully get rid 
of an app

Although you can drag any 

app from the Applications 

folder into the Trash, this 

doesn’t necessarily remove 

it from System Preferences, 

your user’s Library folder, or 

the menu bar. To remove an 

icon in System Preferences, 

≈-click on it, then choose 

“Remove [name] Preference 

Pane.” Next, switch to Finder 

and choose Go > Go to Folder. 

Type ~/Library/Application 

Support and click Go. In the 

window that opens, find the 

folder that relates to the app 

you’re getting rid of and move 

it to the Trash. Restart your 

Mac, then empty the Trash.Remove adware to free up your Mac once more.

23
Change your 

default web browser
Safari is the default web browser for macOS. 

Not all websites work well with it, however, so 

you may prefer to install another one. Most 

third-party browsers will, when first opened, 

ask if you want to set them as your default. 

Otherwise click  > System Preferences > 

General and choose your new browser from 

the “Default web browser” pop-up menu. 

You can change back to using  

Safari in the same place.

24 Remove or change 
a payment method

If you want to remove or update the 
credit card you have on file with 
the App Store, go to  > App Store, 
then, in the store’s Featured tab, 
click Account on the right-hand 
side and sign in with your Apple ID. 
Click Edit beside Payment Information. 
Under Payment Type, select a new card 
type, or click None to remove your card. 
(If you’re the organizer of a Family 
Sharing group, you must have valid 
card details on file.)

25 Run Windows programs
If you need to use a Windows 

program for which there’s no macOS 
equivalent, you can run a virtualized 
version of Windows from the macOS 
desktop using software such as 
VMware Fusion or Parallels Desktop. 
These programs are convenient but not 
free, and will not give you the very best 
performance, as Windows is contained 
inside a virtual machine. Instead, you 
can install Windows alongside macOS 
using the Boot Camp Assistant tool. 
See apple.co/2tZowsu for a full guide.

21 Use Word docs without 
Microsoft Office

The iWork suite (which consists of 
Pages, Numbers, and Keynote) is now 
available for free in the Mac App Store, 
though you need macOS Sierra. They 
can open Microsoft Word, Excel, and 
PowerPoint documents, respectively. 
Each can also export your work to the 
corresponding Microsoft Office format. 
Go to File > Export To and then choose 
the relevant format, such as Word, from 
the options. Click Next in the sheet 
which appears, then Export. 

>>>Feature
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27 Updates need an old 
Apple ID password

If you installed an app on your Mac 
using a different Apple ID to the one 
you use now, the Mac App Store will 
need that ID’s password to update 
the app. If you know the password, 
you can keep updating and using 
the app as normal. If this gets too 
annoying and the app is free to 
download, simply open the 
Applications folder, delete your 
existing copy of the app, then make 
sure you’re signed in to the store 
with your current Apple ID, and 
simply redownload the app. 

28 Restore a missing 
Mac App Store app

If you have a new Mac or have been 
forced to wipe the startup disk to fix 

an error, some of your apps may be 
missing. To restore any app you’ve 
previously downloaded from the 
App Store, go to the store’s 
Purchased tab to see a list of them. 
Click Install next to an app to 
redownload it. To do this, you must 
be signed in with the original Apple 
ID you used to download the app.

29 Restore a missing 
third-party app

If you can’t find an app you 
previously downloaded, this may be 
because it’s no longer available on 
the App Store, or you installed it a 
different way, such as from a CD. 
If you keep Time Machine backups 
you can restore missing apps from 
them using Migration Assistant (see 
bit.ly/migasst). If you obtained an 

app from a third-party site or online 
store, rather than the Mac App 
Store, many of those sources enable 
you to redownload apps, or recover 
the key that removes restrictions 
from a trial version, as long as you 
are able to sign in to your account.

30 Change the app used 
to open a file type

Many file types, such as text files, 
can be opened by various apps. If you 
want to change which app is used to 
open a file, ≈-click on the file in 
Finder and choose Get Info. In the 
window that opens, click the triangle 
next to “Open With” and choose 
your preferred app from the pop-up 
menu. Click the Change All button 
to ensure your Mac uses this app for 
all files of this type.

Use Finder’s Get Info window to change the app that’s used to open a particular file type.
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34Correct 
the time

An incorrect system time can 

lead to all sorts of issues with 

web pages not loading 

correctly. To update this 

setting, go to  > System 

Preferences > Date & Time. 

Click the padlock at the 

bottom left, then enter an 

administrator account’s 

password to make changes. 

Make sure “Set Date and 

Time Automatically” is 

checked, and that you’re 

using your nearest 

time server – say, Apple 

Americas. Next, go to the 

Time Zone tab and select 

your country from the map, 

or use the Closest City menu. 

31 Speed up your system
If your system is running slowly, 

save any open files, restart your Mac, 
and  run a software update by going to 
 > App Store > Updates. One common 
reason for a slow system is having too 
many apps actively doing stuff at once; 
try quitting a few of them.

Consider how many items are set to 
open at login, too – go to  > System 
Preferences > Users & Groups > [your 
account] > Login Items to check and 
remove unnecessary ones. It’s wise to 
remove any items you don’t need. If this 
doesn’t have an effect, try starting up in 
safe mode (refer to bit.ly/macossafe) 
to make sure third-party software isn’t 
responsible. Safe mode automatically 
scans and repairs corrupted system files 
on your startup disk, too. 

32 Find a missing file
If you’re sure you saved a file but 

don’t know where, click Spotlight’s icon 
at the top right to search for the file’s 
name – say, “vacation.” Alternatively, 
press å+ç+[spacebar] and use 
the + (top right) in the window 
that opens to add criteria to look 
for files by kind or extension, such 
as JPEG images or “jpg.”

If your file is still missing, 
it may have accidentally been 
deleted. If you’ve been keeping 
Time Machine backups, you can 
restore items by following the 
steps at bit.ly/usetimemac. 

33 Fix failing backups
If you back up your Mac with 

Time Machine, you may see an 
alert saying a backup couldn’t 
be completed. If you use an 
external drive to back up, reseat 

the connection, click the Time Machine 
icon in the menu bar, and choose Back 
Up Now to try again. If you’re using a 
Time Capsule, update its firmware 
(see bit.ly/airptupd), then restart it. 
Make sure your Mac is connected to the 
same network as your Time Capsule. 

36 macOS freezes  
after login

Sometimes your Mac will start up but 
then freeze on login. Its screen may even 
turn blue. If other users can log in to 
the Mac without any trouble, the issue 

+ macos
irritAtioNs

Grapple with some common  
eccentricities of macOS itself

35
macos won’t start

If the operating system won’t start up, check 

carefully for any error messages. A flashing 

question mark signifies that the system 

software wasn’t detected, and may indicate 

a hardware issue. Contact Apple Support if this 

happens. If your Mac displays a blank white or 

gray screen with a loading bar, remove any 

peripherals and perform an SMC reset (see 

apple.co/1eNyxqS). If startup still fails, 

contact Apple Support for further  

troubleshooting.
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40 Fix the 
message 

“Your startup disk 
is almost full”
You will see this message if 

there’s very little free space 

on your Mac’s main storage. 

In  > About this Mac, click 

the Storage tab to see what 

data’s taking up the most 

space. Click the Manage 

button to store some of 

your files in iCloud, remove 

watched movies and TV 

shows, and automatically 

empty the Trash each month. 

Additionally, items in your 

Downloads folder can usually 

be safely deleted as you can 

often download them again 

if needed.

is most likely to do with incompatible 
software or a corrupt font. You need 
to restart your Mac in safe mode (see  
bit.ly/macossafe), then go to System 
Preferences > Users and Groups. 
Click your user on the left, then the 
Login Items tab to check for third-
party apps that may be causing this 
problem. Also read bit.ly/rmvfont.

37 Force your Mac  
to shut down

On occasion, your Mac will refuse to 
power off; if another user is logged in, 
macOS will prompt you to enter an 
admin password first. If that’s not the 
case, you likely have a crashed app 
that’s stopping macOS from restarting. 
Save any files that you’re working on, 
then click  > Force Quit. Select an app 
and click Force Quit, then try shutting 
down; repeat if necessary. 

38 Reinstall macOS
If your system is still behaving 

badly, you can try to erase the startup 
disk and reinstall macOS. To do this 
you’ll need to know the Apple ID and 
password you used to install it. Make a 
backup if you can, then restart the Mac 
and hold ç+R at the startup sound. 
Follow the steps at bit.ly/reinstmac 
to set up as new, or bit.ly/rstrtime to 
restore from Time Machine backups.

39 Reset login password
If you’ve forgotten the password 

you use to log in to your Mac, the easiest 
way to reset it is to have an admin user 
do it for you. Ask them to go to System 
Preferences > Users and Groups, select 
your account, then click the Reset 
Password button. After resetting your 
password, you’ll need to create a new 
login keychain – see bit.ly/rstkeych.

50 quick fixes for macOS and iOS
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43
Detect 
a faulty 
charger
If your MacBook 

isn’t charging, check 

that its power adapter 

is correctly connected 

and try a different wall 

socket. If this fails, remove 

the charger and inspect 

the charging port on your 

MacBook to make sure there 

are no foreign bodies in it. 

Carefully examine your 

charger for any frayed or 

exposed wires. If you find 

anything, take the MacBook 

and charger straight to an 

authorized repair center. 

If the cables and port seem 

in order, try performing 

an SMC reset – see bit.ly/ 

restsmc for instructions.

+ HArDwAre
HAssles

Learn to detect common issues 
with your Mac’s hardware

45 Check your warranty
Visit checkcoverage.apple.com 

and enter your serial number to check if 
your device is in warranty or covered by 
the AppleCare Protection Plan.

In addition, the Uniform Commercial 
Code, which all states have adopted in 
some form, provides an automatic 
“implied warranty of merchantability,” 
which guarantees that consumer 
products are free of substantial defects 
and will function properly for a 
reasonable period of time.

What’s “reasonable” varies from state 
to state and depends on the product, but 
generally the period is limited to four 
years by law.

44
isolate hardware issues
Issues with your Mac, such as no sound, 

the display appearing incorrectly, or slow 

performance, can be caused by both hardware 

and software issues. If any error messages 

appear, make sure to copy them down exactly. 

Also note down the time they’re happening.  

Next, go to getsupport.apple.com on a  

working device to chat to Apple Support, 

which will be able to tell you if it sounds  

like there’s a hardware problem  

with your Mac.

41 Deal with an 
overheating Mac

If the fans on your Mac are constantly 
running, or it’s uncomfortably hot to 
the touch, there may be a hardware 
fault. Place the machine on a hard 
surface to allow better air circulation; 
Apple recommends a maximum 
operating ambient temperature of 95° F. 
If the fans are still running constantly, 
try performing an NVRAM reset (see  
bit.ly/resetnvram). Noisy fans and 
overheating can be caused by software, 
such as Spotlight reindexing, so contact 
Apple Support before you take your Mac 
to a repair center. 

42 What does this 
startup sound mean?

Macs sometimes beep on startup; the 
number and frequency of these beeps 
can help you understand an issue with 
your Mac. If you hear a beep every five 
seconds, no memory modules are 
detected; three beeps means the 
memory hasn’t passed the integrity 
check. If you hear three long, then three 
short beeps, the Mac’s firmware has 
been corrupted, and you need to 
take your computer to a repair center.
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50Memory 
upgrades

The more memory your Mac 

has, the less likely it is that 

macOS will need to move data 

for an idle app to storage to 

free it up for something else, 

and back to memory when it’s 

needed. So, you may want to 

upgrade your Mac’s memory. 

Some repair centers can do 

this, but you can do it yourself 

on many older Macs. Identify 

your model in  > About This 

Mac, click the Memory tab to 

see how much is installed, 

then click Memory Upgrade 

Instructions. Note that some 

Macs can’t be upgraded at all.

46 Use Apple Diagnostics
Your Mac includes one of two 

diagnostics suites, depending on your 
model’s age – see bit.ly/appltests for 
full details. To run either, shut down 
your Mac, then disconnect all external 
devices except the keyboard, display, 
and mouse. Next, power on the Mac 
while holding d. Choose your language 
if prompted, then the test will start. 
If issues are found, take a photo of the 
screen or note down any reference codes 
before contacting Apple Support.

48 Dimmed screen
Occasionally you may 

see a dimmed screen on 
your Mac, saying you have 
to restart your computer. 
This can be caused by a 
number of issues, from 
corrupted system updates 
to a serious hardware 
failure. Restart the Mac 
as it suggests. If you see 
more “kernel panics,” 
disconnect any 
peripherals and try 
starting up in safe mode 
(bit.ly/macossafe) to 
see if the issue persists 
there. If the issue does continue, 
contact Apple Support for further help.

49 Spot display anomalies
Every now and then a transistor 

on your Mac’s display may fail, causing 
a small area either to go dark or stay 
bright. Sometimes display issues are 
caused by a foreign object such as dust 
particles getting behind the screen. 
If you have display issues, clean your 
screen with a dry cloth and perform 
an NVRAM reset – see how at bit.ly/
resetnvram. If this fails to fix it, visit 
your local Apple Store for advice.

47Fix common 
sound problems

If you can’t hear any sound on your 

Mac, make sure there are no external 

audio devices connected such as 

headphones. Next, go to System 

Preferences > Sound. Click the Output 

tab and make sure internal speakers 

are selected. If you can’t see this 

option, contact Apple Support. 

If “Internal Speakers” is selected, 

turn up the volume and perform 

an NVRAM reset (see bit.ly/reset 

nvram). If you hear the normal 

startup sound, your Mac’s issue 

is software related. Otherwise, 

it’s likely a hardware problem.

It may “sound” 
obvious, but check 
the headphone jack…
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A
pple’s app for storing your 
entertainment media doesn’t 
always receive the recognition 
it deserves, as many of us tend 

to use a handful of its features. Even 
ardent fans are sometimes bewildered 
by navigating their media in it.

The situation isn’t helped by the 
fact that iTunes has undergone many 
changes over the years, from removing 
DRM (Digital Rights Management) 
from purchased music to scrapping 
iTunes Radio in favor of a paid service 
for Apple Music subscribers, along 
with an interface revamp and 
subsequent refinements.

In this guide, we’re focusing on 
some of the handiest yet less well 
known features of the app. Firstly, 
we’ll take a more literal approach 

to “hidden” features by helping you 
to locate lost purchases from the 
iTunes Store, as well as how to move 
your iTunes library to an external drive 
to save space on your Mac. 

You’ll also learn how to import 
and manage content that you rip from 
CDs or download from stores other 
than Apple’s own. This includes 
editing descriptions and adding album 
artwork. And if you love radio, you’ll 
discover how to access online stations, 
including adding your favorites.

Finally, you’ll discover how to get 
great value from iTunes’ MiniPlayer, 
which enables you to queue music, 
browse your library, and control 
playback in a smaller window while 
you carry on working, browsing, 
or playing in other apps. 

Dive deep

iTunes
into

Uncover the 
powerful hidden 
features of your 
media library
By NaTe Drake
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Dive deep into iTunes
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WiTh iTuNes, all your music is at 
your fingertips – but sometimes it’s 
not always there! If for some reason 
newly purchased content from the 
iTunes Store doesn’t appear in your 

library, it’s likely that the download has failed. 
The simplest remedy is to go to iTunes > Account > 
Check for Available Downloads. Enter your Apple 
ID’s password and press ®. If there’s any 
purchased content available to download, iTunes 
will retrieve it for you – note that downloads will 
start automatically when you choose this option. 

If you’d prefer to view what content is available 
before clogging up your Mac’s storage with music, 
apps, and videos, follow the steps in “How to 
redownload past iTunes purchases” later in this 
feature to view media you’ve previously purchased, 
so you can pick and choose what to download.

If you’re using Apple’s Family Sharing feature 
(see bit.ly/famsharing), not only can you download 
content you’ve purchased using your own Apple ID, 

Find 
iTunes 
content
Music at your fingertips, if you 
can find it… Here’s how to locate 
your missing iTunes purchases

>>>Feature
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but also most media other family members have 
bought using their personal IDs. At the view of your 
past purchases, click your name at the top left of 
the window and choose a family member, then 
download their content just as you would your own.  

hiDDeN purchases

While sharing purchases with your family saves 
each of you from having to buy your own copies of 
music and movies, you may prefer that your loved 
ones didn’t know you’re secretly a fan of trashy 
’80s pop music. In light of this, Apple allows you 
to hide previous purchases, so that they don’t 
appear in the Purchased section of iTunes, for you 
or other family members. Follow steps 1 and 2 of 
“How to redownload past iTunes purchases”, but 
instead of downloading an item, click the “X” next 
to a purchase to hide it from view.  

To make a hidden purchase visible again, go to 
Account > View My Account, then enter your Apple 
ID’s password and press ®. Under the “iTunes in 
the Cloud” heading, click Manage to the right of 
Hidden Purchases, choose the type of media you’re 
looking for at the top right, then click Unhide next 
to an item to restore it to your list of purchases. 
Remember that if you’re using Family Sharing, 
all family members will then be able to see and 
download the unhidden content.

MeDia MaNageMeNT

You may want to automatically download iTunes 
Store purchases in future, so that your Mac contains 
a copy of all media that you purchase on any devices 

signed in to your Apple ID. In iTunes > Preferences, 
click the Downloads tab to view your Automatic 
Downloads settings. Make sure “Always Check for 
Available Downloads” is enabled. You have the 
option to treat kinds of media differently – on a 
portable Mac with limited storage, say, you might 
want music you purchase on your iPhone or iPad to 
download automatically, but not movies. If space 
isn’t an issue, consider leaving “Download full-size 
HD videos” checked to ensure videos are received at 
the best available quality.

If you enable automatic downloading of videos, 
though, there’s an easy remedy for ensuring things 
you’ve watched don’t clog up your Mac’s storage. 
Go to iTunes > Preferences, click the Advanced tab, 
and enable “Automatically delete watched movies 
and TV shows” to have iTunes free up space for you.

If you’re a music lover, consider following the 
steps at bit.ly/getapplemusic on how to sign up for 
the Apple Music subscription service. Apple Music 
includes a feature called iCloud Music Library – 
also part of the older iTunes Match service – which 
ensures a copy of the music on your Mac is stored 
online. Rather than manually syncing, tracks are 
streamed over the internet to your other devices, so 
they don’t have to take up huge amounts of space.

you May preFer ThaT your 
loveD oNes DiDN’T kNoW you’re 
secreTly a FaN oF Trashy ’80s 
pop Music, so you caN hiDe iT

For iTuNes 

to play content 

from the iTunes 

Store, your Mac 

must be associated with 

your Apple ID. You can have 

up to 10 devices associated 

with your Apple ID and 

iTunes Store account at 

any time, though no more 

than five Macs or PCs.

This can be problematic, 

as over time you might 

associate different devices 

with your Apple ID. To check 

how many you have, make 

sure you’re connected to 

the internet, then open 

iTunes and choose Account 

> View My Account. 

When your account info 

appears, find the “iTunes in 

the Cloud” heading and click 

Manage Devices there. This 

will reveal a list of any iOS 

devices, Macs, and PCs that 

are linked to your Apple ID, 

which grants those devices 

the ability to automatically 

download iTunes and App 

Store purchases, or to 

redownload past purchases. 

Click Remove next to any 

device you no longer use. 

You should also do this 

if you’re selling or giving 

away your Mac.

To add a new Mac or PC, 

in iTunes choose Account > 

Authorizations > Authorize 

This Computer. Enter your 

Apple ID’s password; after 

a few moments you’ll see 

a confirmation.

 > associated devices

Dive deep into iTunes
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hoW To Redownload past iTunes purchases

View past purchases
In iTunes’ Account menu, look 

for a Sign In option; if it’s there, choose 

it, then enter your Apple ID and its 

password to continue. Otherwise, choose 

Purchased, or Family Purchases if you’ve 

set up iCloud’s Family Sharing feature.

View purchases
Click on a media type, such as 

Music, near the top right to view past 

purchases of that kind. If you’re part of 

a Family Sharing group, you can click 

your name (top left) then a family 

member’s name to view their purchases. 

Download items
Click the cloud icon next to the 

item you want to download. Once that’s 

done, double-click the item to play it 

right away, provided your Apple ID is 

authorized for playback on this Mac; if it 

isn’t, look in Account > Authorizations. 

If you have a large amount of music imported 
from CDs, or lots of home videos, you may want to 
store your entire library on an external drive. Before 
and after you migrate your library to an external 
drive, run List MIAs (donationware, bit.ly/listmias) 
to verify that files for all items are where iTunes 
expects them to be. Once that’s done, create an 
empty folder on the external drive: in Finder, go 
to File > New Folder, and name it “iTunes Media.” 

Next, go to iTunes > Preferences > Advanced and 
ensure “Keep iTunes media folder organized” and 
“Copy files to iTunes Media folder when adding to 
library” are enabled. The former causes files to be 
renamed and reorganized; it’s not strictly 
necessary, but without it some people report 
finding broken links in their library, notably 
where media was originally stored outside of the 
iTunes Media folder.

Click the Change button next to “iTunes Media 
Folder location,” navigate to the folder you just 
created, click Open, then click OK. You’ll be asked 
to confirm that iTunes should move and rename 
files in your new iTunes Media folder. Click Yes. 

Choose File > Library > Consolidate Files to begin 
copying from your Mac to the external drive. Make 
sure the drive is connected to your Mac when you 
want to play content in iTunes. After migrating, use 
List MIAs, mentioned earlier, to check for broken 
links, and follow bit.ly/itunesloc to fix them.

>>> The lisT Mias tool is an 

AppleScript that helps you out 

with situations like this. It runs 

through all the items in your 

music library and checks the 

files they link to actually exist. 

However, you don’t fix broken 

links from its window; you still 

do so in iTunes, which cleverly 

scans for any other missing 

files relative to the one you 

point it at.

>>>Feature
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 Make iTunes 
your own
Add music from CDs and other 
download stores, plus album 
artwork and other media –
including internet radio streams

There are thousands 

of stations available as 

streaming internet 

services, and you can 

listen to many of them in iTunes. 

To get started, select Internet Radio 

from the pop-up menu near the top 

left of the app. If you don’t see this 

option in the list, choose Edit Menu 

instead and follow the steps we’ve 

listed in the main article to add it.

As there are so many stations, 

iTunes lists them by category, such as 

Classic Rock. Click the small gray 

arrow next to a category to see the 

available stations of that kind, then 

double-click one to start streaming it.

If a radio station isn’t listed, go to 

File > Open Stream. Type the stream’s 

address and click OK. Any stations 

you stream this way are automatically 

added to a playlist named “Internet 

Songs.” You can edit the name and 

other metadata for stations in this 

playlist the same way as other library 

items: select one and press C+I.

 > radio gaga

oNce you’ve reDiscovereD old 
iTunes Store purchases, you may 
want to start adding more content 
to your library. Although you can 
sign up for Apple Music to access 

millions of tracks, you might add music from CDs, 
or tracks you’ve purchased elsewhere online.

While ripping music from CDs is less common 
these days, you may well have other media you’ve 
purchased online from Amazon or maybe even 
artists’ own websites, or downloaded for free from 
sites like Soundcloud (soundcloud.com). One little 
known feature of iTunes is that adding this content 
to your library is as simple as using the copy and 

Double-click on an internet radio station to 
begin streaming it. Choose File > Open Stream 
to add a new station by entering its address.

Dive deep into iTunes
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paste commands in Finder. Say you have a folder 
of MP3 files provided as a bonus for buying a vinyl 
album from an artist’s online store, which is a fairly 
common thing these days; simply copy or move 
that folder to the one named “Automatically Add 
to iTunes.” You’ll find the latter folder located in  
/Users/<your username>/Music/iTunes/iTunes 
Media by default. If you followed the steps to 
transfer your iTunes Media folder to an external 
drive, as detailed in the previous section, navigate 
to the folder there instead.

In this location, place your music and/or video 
files in the “Automatically Add to iTunes” folder 
and they’ll be added to your library when iTunes is 
open. Note that this only works for files that are in 
a format iTunes can understand, such as MP4 video 
files and MP3 and AAC audio files.

MaNage your MeTaDaTa

When you import an audio CD to iTunes, the app 
connects to the online Gracenote database to look 
up info about the disc’s artist, tracks, and artwork. 

 > check icloud Music 
library upload status

WheN you connect 

iTunes to iCloud 

Music Library, tracks 

that aren’t available 

in Apple’s huge catalog are 

uploaded to your online library. 

Fortunately this doesn’t use up 

any of the storage quota for 

your iCloud account. 

iTunes downsamples files that 

are above a certain quality into 

256Kbps AAC files, yet the high-

quality original on your Mac is 

left untouched. Tracks are 

ineligible for upload if they’re 

too long, their file size is too 

large, or they’re encoded at too 

low quality. Apple describes the 

conditions at apple.co/2tqmbHk.

To find out if any of your 

tracks have failed to upload, 

choose File > New > Smart 

Playlist. Set the playlist’s rules 

to match the iCloud Status of 

tracks to any of “Ineligible,” 

“Error,” or “Not Uploaded.”

 The MiniPlayer can vary 

in size, showing as little 

as the current track’s name, 

artist, and elapsed time.

 Put the pointer over the 

MiniPlayer (in any of its 

configurations) to reveal 

additional controls.

 With those controls 

visible, click the ellipsis 

to reveal commands related 

to the current track, and to 

show or hide artwork and the 

Up Next playback queue.

 Click the magnifying 

glass (or press ç+F) 

to search for tracks – either in 

your library or Apple Music’s 

catalog – to play immediately 

or queue up for later.

 Click the bulleted list to 

show or hide the queue, 

or drag the window’s bottom 

edge down to reveal album 

art and then the queue. Drag 

up to hide them again in the 

reverse order. Put the pointer 

over a result from your library 

and click the ellipsis for 

queueing options. (Clicking 

an Apple Music item reveals 

it in iTunes’ main window.)

hoW To Use the MiniPlayer

>>>Feature
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If the album isn’t in the database, you’ll see a list 
of numbered track titles and no album cover, and 
the title may also be incorrect. Follow the steps in 
“Customize your albums” to fix this.

After you update a disc’s details and import its 
contents, you may find no image of its artist is 
shown in iTunes’ Artists view of your music. If you 
have an Apple Music (or iTunes Match) sub, you can 
fix this in iTunes > Preferences > General by turning 
on iCloud Music Library. If the artist has material in 
Apple Music’s catalog, their picture will be shown 
in the Artists view after the app next auto-updates 
your online library, or after forcing a manual update 
using File > Library > Update iCloud Music Library.

Enabling iCloud Music Library makes music in 
iTunes on your Mac available online. It can take a 
while to upload the tracks, depending on the size 
of your library, how many tracks can be matched 
against Apple Music’s catalog, and the speed of 
your internet connection. If content from your 
library isn’t in Apple Music’s catalog, iTunes 
automatically uploads it (with some exceptions – 
see “Check iCloud Music Library uploads”).

Using iCloud Music Library on your Mac enables 
music you add to iTunes to be played on other 
devices you also connect to it – on other Macs and 
PCs, iPhone, iPad, and Apple TV.

 
MiNi TreaTs

While our guide mainly focuses on music and video, 
iTunes can play many kinds of content that aren’t 
listed by default. To discover them, click the pop-up 
menu near the top left of iTunes and choose Edit 
Menu. Put a check mark next to media types you 
want to organize and play in iTunes. Click Done, 
and you’ll be able to choose those kinds of media 
from the pop-up from now on.

The additional media you can play in iTunes 
includes internet radio stations. See “Radio Gaga” 
on the previous page to learn how to set this up. 
You can listen to Beats 1 without an Apple Music 
sub, though other features under Radio require one. 

If you want to keep an eye on what’s playing, 
consider using iTunes’ MiniPlayer instead of 
switching between iTunes and other apps. This is a 
smaller window that shows the currently playing 
track. You can extend its height to reveal the Up 
Next queue, and search your library or Apple 
Music’s to line up things to play. To switch to it, 
choose iTunes > Window > MiniPlayer.

While the MiniPlayer is convenient, it’s also easy 
to lose track of it among other windows. In iTunes > 

Preferences > Advanced, put a check mark next 
to “Keep MiniPlayer on top of all other windows” 
to avoid this. You can drag the MiniPlayer to a new 
position on the desktop. However, note that it 
won’t be shown when you’re using an app in 
full-screen mode.

Hopefully our guide will have convinced you 
that iTunes is a powerful media manager with 
hidden depths that make it worth engaging with. 
If there are features you’d like to see added or 
improved, you can share your thoughts with 
Apple at apple.com/feedback/itunesapp.html.

 > customize your albums
iF aN audio CD 

isn’t recognized 

by the Gracenote 

database, the 

album will lack proper artwork. 

In this instance, if you’ve 

already imported the album 

into iTunes, go to your music 

library and look under Recently 

Added, ≈-click the album’s 

placeholder artwork and 

choose Get Info. iTunes will ask 

to confirm that you want to 

edit multiple items. Click Edit 

Items to open a new window.

Select the Artwork tab. This 

will simply show a blank space. 

To add artwork, either drag an 

image from Safari or Finder 

and drop it onto the space, or 

click the Add Artwork button to 

find an image on your Mac.

At this stage, you may also 

want to click on the Details tab 

to update the album’s title, 

artist, year, and so on. Use the 

Options tab to set the media 

kind, or to ask iTunes to 

remember the playback 

position for this track between 

sessions, which is switched off 

by default. You may want to 

amend the last two attributes 

for an audiobook, for example.

Under Sorting you can set 

the order things are listed in 

your library. Artists are sorted 

by first name by default, but 

you can assign separate names 

for display and ordering.

Dive deep into iTunes
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The movable Before/After 

preview lets you judge 

changes as you make them, 

halving the view or showing 

the whole image twice.

The Frequency Separation filter 

quickly splits an image’s detail 

and color into separate layers, 

which you can edit to remove 

blemishes seamlessly.

Adjustments and filters are 

applied in separate layers by 

default, so you can reverse 

the changes you make at 

any subsequent point.

app tips

Get the most from editing features

Here, for the first 
time, is a complete 
professional photo 
editor on the iPad. 

Compared to its acclaimed 
macOS version, the neat dark 
interface has been adapted to 
save space, with palettes 
docked into a single column 
at the right and tools down 
the left that change according 
to the mode – or “persona” – 
selected at the top. Photos 
can be imported from the 

Affinity Photo
Professional image editing on the iPad
$29.99  From Serif Labs, affinity.serif.com

Made for iPad  Needs iOS 10.3 or later, iPad Pro, iPad Air 2, iPad (2017)

Photos app or iCloud Drive, 
but not directly from other 
apps or Dropbox.

When you open brushes or 
filters, their controls appear 
at the bottom and stay in place 
while you open other palettes, 
until something overrides 
them. That can get confusing, 
but it’s vital when, say, you 
want to watch the histogram 
to check the effect of an 
adjustment. Alternatively you 
can display a vectorscope or 

RGB parade – tools more 
familiar to video colorists – 
or a power spectral density 
plot, used in scientific analysis. 
You don’t even get all these 
options in Adobe Photoshop 
CC, which would cost you 
the same for two months’ 
subscription as it does buying 
Affinity Photo outright. The 
Frequency Separation filter 

The Refine Selection tool can help to 
clean up and smooth complex outlines.
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Affinity Photo

   Comprehensive tools 
reflect pro methods

  Generally responsive and highly usable

  A few niggling omissions

  Interface can get mildly confusing

excellent 

splits out the detail in an 
image from the shading so 
you can edit them as separate 
layers, an essential pro 
portrait-retouch technique. 
Unlike other iOS graphics apps, 
Affinity Photo lets you edit 
images in CMYK or LAB color 
as well as 8- and 16-bit RGB, 
and handles raw files too, in 
its Develop persona. Images 
can be stacked for HDR 
processing, focus merging, 
and more.

If that all sounds a bit 
technical, a batch of video 
tutorials can get you started, 
and a text-based help guide 
is available from the main 
screen. But if you just have 
simple tasks in mind, all the 
filters and adjustments you 
would expect are reasonably 
accessible. Layers, masks, and 
channels work in familiar 
ways, and the Selection 
persona offers tools like the 
Smart Selection Brush and 
Refine Selection to tackle 
complex edges. Layers can take 
effects such as soft shadows, 
useful when you add vector 
shapes and text. Affinity Photo 
imports and exports layered 

PSD files, among other 
formats, although it can’t 
save clipping paths.

A few key tools, such 
as Levels and Highlights/
Shadows, didn’t work the way 
we expected them to, and we 
missed the ability to instantly 
check the RGB or CMYK value 
of a pixel. Only one palette can 
be open at a time, and to close 
it you have to find and tap its 

icon again; a “Close the open 
palette” button would be 
simpler. We’d like more 
keyboard shortcuts and less 
glitching: A few operations 
slowed the app to a crawl, 
and it crashed occasionally, 
although automatic saving 
meant we lost hardly any work.

Unlike a mouse or graphics 
tablet, using the touchscreen 
does risk your finger getting in 
the way, and for that reason 
we found the iPad Pro’s Apple 
Pencil easier to use – but you 
can manage without it.

 tHE BOttOM LiNE. Affinity 
Photo is a triumph: an iPad app 
made for serious creative 
users, with room to get even 
better. adaM BaNks

Raw photos can 
be imported from 
most DSLRs, so 
you can edit with 
no loss of quality.

Modern features like Haze Reduction make it easy to get the best from your photos.
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Night Sky enables 
you to view 
constellations of 
stars and planets – 

not to mention satellites – on 
your iPhone or iPad, in real 
time. Hold your device up to 
the sky and the app tells you 
exactly what you’re looking at. 
An augmented reality view 
overlays the constellations, 
planets, and names on the 

Night Sky
Twinkle, twinkle, little star…
Free (Premium subs: $1.99/mo, $9.99/yr) From iCandi, icandiapps.com  

Made for iPad, iPhone, watchOS, Apple TV  Needs iOS 9.3 or later

The detail available on 
every constellation, like this 
entry for Leo, is incredible.

Night Sky 4.4

  Masses of detailed information

   Explore sky from around the world

   New data on light pollution and  
stargazing conditions

   There’s no one-off premium price

ExcEllENt 

view from your iPhone’s 
camera. You can, of course, 
pan and zoom to see more or 
less detail as you gaze.

There’s a great deal more to 
Night Sky than that, however. 
Version 4.4 brings several new 
features including a World 
Traveler mode. This allows you 
to choose any location on the 
planet and explore the sky 
from that area. There’s 
information on light pollution 
and stargazing conditions, as 
well as rise and set times for 
the sun and moon.

Also new in 4.4 is VoiceOver 
support, and a section that 
provides detailed information 
on the 2017 US solar eclipse, 
showing the event from 
different locations complete 
with timings.

Night Sky also has an 
astro-photography tool that 
provides you with camera 

settings designed to get the 
best possible shot of whatever 
you’re trying to photograph in 
the sky, from a bright 
constellation to a single planet. 
Bear in mind, though, it’s not 
going to work miracles.

A couple of features are only 
accessible with a monthly 
subscription. The first of them 
enables you to tour the moon-
landing sites recreated from 
the Apollo 11 and Apollo 15 
missions. The other premium 
feature is Night Sky Tonight, 
an animated view of the sky 
above you from sunset to 
sunrise the following morning. 
We wish it were possible to 
view this full-screen, though.

The wealth of data and 
information that’s available 
in Night Sky is incredible – 
everything you could want to 
know about every satellite, 
constellation, and planet is 
here. Apple TV and Watch apps 
are included, the latter using 
Series 2’s GPS and gyroscope to 
enable identification of things 
in the sky by raising your wrist.

The BoTToM LiNe. Whether 
you’re an astronomy geek or 
have just a passing interest, 
Night Sky is a fascinating joy. 
KeNNy heMPhiLL

World Traveler 
mode lets you 
see the sky from 
anywhere on 
the planet.

42   Sep 2017  maclife.com



Adobe Scan is yet another 

app that uses your device’s 

camera to capture images of 

documents and turn them 

into PDFs. But it justifies its existence by 

making great PDFs fast, with free and 

automatic optical character recognition – 

so you can search for text in them and 

copy and paste that content elsewhere.

Auto-Capture does a wonderful job 

even in low light, highlighting your 

document in blue so you can confirm it’s 

looking at the right thing. Or you can 

turn off Auto-Capture to scan manually, 

and even create PDFs from images 

already in your photo library.

Documents 6 is a great app 

with terrible timing. In iOS 11, 

Apple will roll out Files, a 

reimagining of the iCloud 

Drive app that also supports other cloud 

services. That’s the same as Documents, 

but Readdle’s app goes even further.

You can download files from the web 

via a speedy built-in browser, add them 

directly to Documents from iTunes, or 

choose “Copy to Documents” from the 

share sheet throughout iOS. Then it’s 

easy to view files, move them, or even zip 

a folder into an archive to send. Readdle 

even nailed drag-and-drop on the iPad 

before it’s added to iOS 11. You can drag a 

Adobe Scan
Makes great PDFs with character recognition
Free  From Adobe, adobe.com

Made for iPhone, iPad  Needs iOS 10.0 or later

Documents 6
One app for any file and any cloud
Free  From Readdle, readdle.com

Made for iPhone, iPad  Needs iOS 9.0 or later

Great 

excellent 

Adobe Scan’s minimal interface shows your 
PDF files and lets you scan new ones.

Documents 6 has a clean, intuitive design and 
provides you with plenty of help.

By default, Scan saves your data to the 

Adobe Document Cloud, which includes 

2GB of storage for free accounts. But you 

can also use the Share option to send the 

scanned PDFs to other apps, including 

Mail, Messages, Dropbox, and Documents.

You can’t do any PDF editing or 

markup inside Scan, however. You need 

Adobe’s free Acrobat Reader app for iOS 

(or another PDF app) to annotate and 

sign your PDFs, but they show up there 

seamlessly via Document Cloud, and 

ready to be searched, marked up, 

commented on, and highlighted.

Both Scan and Acrobat Reader include 

an optional in-app purchase called PDF 

file between Documents on one half of 

an iPad screen and another Readdle app 

(Spark, Scanner Pro, or PDF Expert) on 

the other half. It works seamlessly.

Even with iOS 11 around the corner, 

Documents is worth having for its 

flexibility. You can listen to music stored 

in your iTunes library or streamed from 

the cloud, plus watch video files that 

Apple’s player doesn’t support. You can 

connect to a WebDAV, SFTP, or FTP 

server, not to mention Dropbox, Box, 

SharePoint, OneDrive, Google Drive, 

Windows SMB, and Yandex.Disk. 

The app’s main drawback is that some 

of its abilities depend on other Readdle 

Pack, which, for $9.99 a month, lets you 

combine PDFs and convert them to 

editable Microsft Office documents or 

images. But otherwise Adobe Scan 

delivers without costing a penny. 

The boTToM liNe. Adobe Scan 

works fast and produces solid results 

for free. SuSie ochS

apps — if you try to mark up or sign a 

PDF, you’re prompted to install the $10 

PDF Expert first. But you can always send 

files to other apps (such as Notes, in the 

case of that PDF) to finish a task.

The boTToM liNe. Documents 6 is 

key if you’ve got files in multiple clouds. 

SuSie ochS
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Old men. 
Heartbreak. 
Redemption… 
And lots and lots 

of walking. These are the main 
ingredients of Old Man’s 
Journey, a story told through 
wordless vignettes of one 
man’s life as he walks across 
hills, mountains and seas to 
find… something. You are his 
guide, of sorts, dragging the 

Old Man’s Journey
May the road rise to meet you – literally
$4.99  From Broken Rules, oldmansjourney.com

Made for iPhone, iPad  Needs iOS 10.0 or later

The use of color in this game 
is simply beautiful, going from 
sunsets to candy-colored hills.

Old Man’s JOurney

  Seriously beautiful art

  Simple, and easy to figure out

   The music is worth putting 
on headphones

  Can be frustrating sometimes

awesOMe 

scenery around him to clear 
the path and help him 
continue. You can pull up hills 
to meet his feet, creating 
zig-zags of landscape, or leave 
him to pause on an immovable 
part such as a house, bench, or 
lighthouse, as you rejig the 
curves of the land to create a 
way forward – since you can’t 
move anything he’s on.

There’s a lot of fun to be had 
manipulating the undulating 
countryside and pulling boats 
across water with your finger. 
It feels responsive, and gentle, 
as the curves of the hills slide 
up and down to where you 
want them. There’s also the 
calming pleasure of interacting 
with small objects in the 
background, such as window 
shutters, trees, and waterfalls, 
which react to your touch in 
various ways. It’s a well-
thought out piece of design 

that doesn’t affect the plot in 
any way, but gives you a little 
spark of happiness for making 
a mark on the game.

The world feels vibrant and 
alive, done in a memorable, 
gorgeous pastel crayon style. 
It’s cleverly reminiscent of 
something Mediterranean, 
all soft terracotta and azure 
colors, flowers climbing up 
the plaster of a hotel wall, 
soft clouds scudding across a 
blue, blue sky. The game never 
explicitly reveals where it’s 
set, but you can imagine a 
Greek coast, a small Italian 
island, or the south of France, 
sun-faded and lilac-scented.

The small vignettes - the 
old man’s memories - are 
so perfectly painted and 
composed that you’ll want 
to linger on them for as long 
as possible. 

Old Man’s Journey can be 
slow and even a bit frustrating 
at times - one section set on 
a train particularly so - but 
it just doesn’t really matter 
when the story and the view 
are both heartwarmingly, 
purely good.

the bottoM liNe. One of 
the most beautiful games 
we’ve seen in a while, with a 
story that’ll make you weep. 
Kate Gray
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ArtPassport does one thing, 

but it does it well, showing 

360-degree views of art 

galleries from around the 

world. You can immerse yourself in 

current and archived art installations, 

and not just one or two – the scrollable, 

searchable list has nearly 100 choices 

and counting, from 35 cities in 23 

countries around the world.

Tap one to learn more about the artist 

and exhibition, and then tap Artworks to 

swipe between close-up views of each 

piece to get their names and details, or 

tap Visit to find out how to see the art in 

person. The real attraction is tapping the 

A lot of meditation apps 

want you to sit perfectly still, 

close your eyes, and listen 

to some blissed-out voice 

reminding you to keep breathing. If that’s 

not your idea of relaxing, Sway is worth 

a look. It doesn’t mind if you keep your 

eyes open. It doesn’t have any talking 

at all, just peaceful, calming tones and 

sound effects that put you in almost 

a trance-like state. And you don’t have 

to stay still. In fact, you have to keep 

moving to keep meditating. 

Sway is an interactive meditation 

app, focusing your attention on slow, 

repetitive movement, kind of like tai chi, 

ArtPassport
Visit 360-degree art exhibits
Free  From GalleriesNow, galleriesnow.net

Made for iPhone  Needs iOS 9.0 or later

Sway
Meditation in motion
$2.99  From PauseAble, pauseable.com

Made for iPhone  Needs iOS 8.0 or later

Great 

awesome 

New exhibitions and artists from around 
the world are added constantly.

Once you hit the day’s goal, the session 
doesn’t end – and you won’t want it to.

big “360” button to be dropped into a 

360-degree view of the gallery. From 

there, just rotate your device to see all 

around you; the artworks can be so much 

more stimulating in context than just 

viewed on their own. You can even zoom 

in and out.

You don’t get to “walk” through the 

gallery, but most of them have multiple 

360-degree views so you get a good look 

at everything in the room. If you have a 

Google Cardboard viewer or mobile VR 

headset, you can tap the VR button for 

a stereoscopic view, which is more 

immersive since you just move your head 

to look around, but also means you lose 

one of its inspirations. This makes it a 

more natural fit for noisy environments 

than guided meditation, which works best 

in a quiet space. To keep a Sway session 

going, you have to keep your phone in 

constant motion — not too fast and not 

too slow, or a tone and message on the 

screen prompt you to adjust.

You start with a three-minute goal, 

which increases by one minute each day, 

with an ultimate goal of 20 minutes. 

Best of all, there’s no subscription fee, 

just a one-time purchase that gets you 

six levels that unlock one by one — but 

if you don’t stay at it, you drop a level, 

in order to encourage good habits. 

the zoom feature. ArtPassport doesn’t 

have an iPad version – probably because 

there’s no Google Cardboard for iPad! –

and that’s too bad because the 

360-degree gallery views would look 

great on a bigger screen.

The boTToM liNe. A worthwhile 

download for any art lover. SuSie ochS

Movement is the focus, but we wish 

the app had a “work mode” where we 

could put the phone down but keep 

Sway’s sounds playing, because we think 

we could listen to them for hours.

The boTToM liNe. Even in noisy 

surroundings, Sway brings us inner peace. 

SuSie ochS
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Seemingly designed to 

tweak nostalgia glands, 

Arkanoid vs Space Invaders 

combines two of gaming’s 

oldest designs in a fusion of frantic 

one-thumb gameplay, thumping techno 

music, and eye-searing neon. 

Half the game is borrowed from 

Breakout, where you smashed balls at 

walls of bricks. The rest is ancient blaster 

Space Invaders, in which hordes of blocky 

foes once slowly descended, aiming to 

take over the world.

The mash-up bit is where Breakout 

revamp Arkanoid comes in. In that title, 

the bat was a spaceship, smacking 

Let’s cut straight to the 

point, for those of you who 

never played the 2014 

original: you know the sort 

of brain-melting Escher prints of 

impossible pathways you’d see hanging 

on a math teacher’s classroom wall? 

Monument Valley is a succession of them, 

turned into an indie puzzle game. You 

control Ro and her pint-sized daughter, 

nudging them gently along pathways, 

over bridges and through doorways. The 

catch? You’ve got to build them yourself.

At first, this is simple stuff – twirling 

basic segments around so that they 

connect up from a different angle (just 

Arkanoid vs Space Invaders
Make space for this one to invade your iPhone
$3.99  Developer Square Enix, square-enix.com

Made for iPhone, iPad  Needs iOS 8.0 or later

Monument Valley 2
It’s all a matter of perspective
$4.99  Developer Ustwo Games, monumentvalleygame.com

Made for iPhone, iPad  Needs iOS 9.0 or later

Great 

excellent 

Smash the invaders’ bullets back at them, 
as bricks and enemies whirl menacingly.

When you rotate part of the level on the right, 
the whole darn thing shifts about at once.

ordinance at evil space bricks. Here, you 

get the bricks, but no ball – your bat is 

used to send the aliens’ projectiles back 

at them.

It’s a bit weird at first – and slow, too. 

You wonder why the heroes aren’t 

equipped with actual weapons, and why 

early levels are surprisingly boring as 

you send the odd bullet back towards 

lazily whirling invaders. But about 20 

levels in, Arkanoid vs Space Invaders 

actually starts to click.

First, you realize your enemy is time, 

not the invaders – you must smash 

enough craft or bricks before the clock 

runs down. This becomes increasingly 

don’t ask us how that geometry works). 

Later, you’ll have to hone your spatial 

awareness, as you pull out segments of 

floor and manipulate them in isolation 

before returning them to the layout - 

keeping your fingers crossed that you’ve 

got it right all the while.

If we’re entirely honest, we didn’t 

come up against any puzzles that 

couldn’t eventually be solved by trial and 

error – but mindlessly shifting shapes 

until they click into place is far less 

rewarding than actually putting in the 

brainwork. It’s all bundled up with the 

occasional vaguely philosophical quote, 

but if you’re not the studious type you 

tough, adding a layer of strategy to the 

mix. Secondly, everything speeds up, not 

least when you venture into the deranged 

hard mode, which wipes seconds from 

the clock for every missed projectile.

The result is a great blast, and there 

are even some cameos, with famous Taito 

faces from the likes of Bubble Bobble 

enlisted to power-up your bat.

The BoTToM liNe. A slow starter, 

but this arcade blaster is bright, noisy, 

one-finger fun. Craig graNNell

can always sit back and let it wash over 

you. And my, what a beautiful wash it is.

The closest equivalent, aesthetically, 

is PlayStation 3’s equally mystifying 

Journey, but (original aside) there’s little 

that compares in gameplay. Looks like 

you’ve found a video game your math 

teacher would approve of, after all.

The BoTToM liNe. This stunning 

sequel to the much-acclaimed puzzler is 

absolutely muddly lovely. eMMa Davies

>>>App Life
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There’s no denying that gardening 
is a rewarding hobby, but it can 
also be demanding, frustrating, 
and often downright confusing, 
especially if you’re new to it. 
So if summer’s got you itching to 
get outside with a trowel, this 
handful of apps will get you 
growing like a pro in no time. 

For many people, there’s a lot 
of appeal in producing their own 
veggies. My Potager ($0.99, iPad 
and iPhone) is the ideal companion 
for your kitchen garden, enabling 
you to lay out your plot, keep track 
of how your harvests are going, 
and look up information on your 
various herbaceous delights. 
There’s even info on the phases 
of the moon, if you think that sort 
of thing makes a difference.

If stats are your thing, try 
ePlant (Free with in-app 
purchases, iPad and iPhone) to 
keep track of how your garden 
grows. You can log what you’ve 
done to every plant - whether 

that’s the usual watering and 
fertilizing, or something more 
exotic such as repotting, pruning, 
or even a friendly chat – you know 
what they say! Watching seedlings’ 
measurements means you can 
easily see what’s had an effect, too.

Sadly, not everyone has room 
for a full set of flowerbeds, so if 
you’re short on space, My garden 
Containers (Free, iPad and 
iPhone) will help you make the 
most of what’s available. An 
encyclopedia of pot-friendly plants 
and how to help them thrive, it lets 
you filter by a range of criteria. 
So if you want a purple bloom that 
lives in the sun and can handle 
your neglectful watering habits, 
looks like it’s celosia for you.

If the environment is important 
to you, you’re likely keen to keep 
the bees coming to your yard. 
BeesMart Pollinator 
gardener (Free, iPhone) lets you 
search by ZIP code to see what kind 
of ecological area you live in, and 
then recommends the requisite 
greenery to attract your 
industrious insect friends.

It’s good to have goals, which 
is where PerMaCulture (Free, 
iPad and iPhone) comes in. The 
brainchild of an Australian couple 
pursuing a sustainable lifestyle, 
it’s full of articles and videos 
detailing eco-friendly projects. 
It might not all be achievable for a 
layman, but you’ll certainly absorb 
some fascinating knowledge.

Finally, when your family and 
friends tire of hearing about your 
fondness for foliage, get yourself 
on garden tags (Free, iPad and 
iPhone). Essentially Instagram for 
horticulture, it enables you to 
follow other gardeners, publish 
pictures of your own plot, and even 
set upcoming task reminders for 
the plants in shot. As a bonus, 
being able to tag your photos by 
the season in which they were 
taken means it’s also a great way 
of keeping a visual record of the 
year’s progress.

rounduP

Six apps to grow your garden
Tap your way to green fingers with these six downloads

By eMMa davies

Tagging something “Planted” in My Potager 
turns it blue; harvested tiles are red.

Never considered kale a decorative crop? 
Think again, says My Garden Containers.

Here’s our herb garden – we’re just waiting 
for the Garden Tags likes to start pouring in.
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Despite the recent high-profile 
departure of apps like eBay, 
Google Maps, and Amazon 
from watchOS, there are still 
plenty of independent 
developers willing to support 
the smartwatch platform. 
Among the latest is Clean 
Shaven Apps, whose latest 
effort is a travel currency 
converter – and no, that’s 
not a typo.

While it may seem like a 
curious decision nine years 
after the App Store gold rush, 

Elk
A travel currency converter on your wrist
Free  From Clean Shaven Apps, cleanshavenapps.com

Made for iPhone, Apple Watch  Needs iOS 9.3 or later

Elk takes a unique approach 
that requires no keypad 
number entry. That’s not 
actually as limiting as it 
sounds, since you can swipe 
left to increase the values or 
right to decrease. Should you 
require greater accuracy, 
tapping a value allows for 
more granular control by 
turning the Digital Crown.

Although Elk is technically 
free, that only gets you support 
for your local currency, plus 
a curated selection of five 
popular rates – which kind of 
defeats the purpose. To unlock 
the full currency lineup, 
there’s a one-time $3.99 
in-app purchase available 
through your iPhone, or you 
can opt for a free 14-day trial 
to take the full version of Elk 
for a spin before buying.

Despite it being optimized 
for watchOS 3, we did have 
issues launching Elk for the 
first time on our first-gen 
Watch – but uninstalling, 
rebooting the smartwatch, 
and reinstalling got things 
working. To be fair, this 
happens a lot on our device, 
but Elk seemed to be more 

stubborn than normal; the 
Watch app also failed to 
properly recognize the free 
trial had been activated.

The boTToM liNe. Spend 
some time with the free trial 
before committing to buy, 
then wait for more bug fixes. 
J.R. bookwalTeR

elk – travel 
currency calculator

  Location-based currency calculator

   Works better on Apple Watch 
than on iPhone

    Installation, in-app purchase bugs

    Free version limited to six currencies

Solid 

Here’s an oldie but 

goodie worth 

repeating: Rather 

than open Workout 

with finger taps, 

raise your wrist 

and say “Hey Siri” 

followed by the 

type of activity you 

want to engage in. 

For example, before 

heading outside for 

a walk, initiate a 

workout by saying 

“Hey Siri, start an 

outdoor walk.”

waTch Tip

Quickly start a workout
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Readers with kids will 

instantly recognize the 

subject of our next app. 

Fidget Spinner Plus is 

yet another simulated 

version of those 

annoying real-world plastic widgets 

found in retail stores everywhere. 

Unlike the real thing, this won’t cost 

you a dime, and there are 14 different 

spinners to choose from — or you can 

create your own using one or more 

custom colors on the iPhone app.

On Apple Watch, turning the spinner 

is done by rotating the Digital Crown or 

multiple taps or swipes on the display, 

while Force Touch changes to 

a different type of spinner. There’s 

even a Complication that can be used 

to launch your favorite spinner right 

from any supported Watch face.

There are no sound effects on Apple 

Watch, but the ad-supported iPhone 

app offers audio plus a game play field 

where you can bounce the spinner 

around the screen, plus Battle Mode 

for playing with two spinners at once.

The boTToM liNe. Mildly 

entertaining, but it works better 

on iPhone. J.R. bookwalTeR

As the name implies, 

Color Pong is a clone of 

sorts of the Atari arcade 

classic that you can 

purchase once and play 

on all of your non-Mac 

Apple devices — including Apple TV and 

Apple Watch. That sounds like a pretty 

great deal considering the app is free, 

but the experience isn’t quite ideal 

when playing from your wrist.

Although Watch owners play against 

the app — there’s no two-player mode — 

turning the Digital Crown moves both 

paddles at the same time. This isn’t a 

problem in and of itself, but sometimes 

the ball accidentally bounces off the 

net instead, not to mention it moves a 

tad too slow.

Sadly, the gameplay is also hindered 

by choppy frame rates, but at least 

there are some basic sound effects to 

spice things up a bit. There’s nothing 

new here, and we’ve certainly seen 

better Pong imitators for Apple Watch, 

but it’s hard to argue with free.

The boTToM liNe. Choppy, buggy 

gameplay mars an otherwise decent 

take on an arcade classic, now in color. 

J.R. bookwalTeR

Fidget Spinner Plus
Is this still a thing? Apparently so…
Free  From Paul Dumais

Made for iPhone, iPad, Apple Watch  Needs iOS 9.0 or later

Color Pong
The future of Pong is finally here!
Free  From Pallavi Kalyanam, pallavi.vijayanathan.com

Made for iPhone, iPad, Apple Watch, Apple TV  Needs iOS 10.1 or later

Solid 

okay 

STep coUNTiNG 

Open the free StepsApp 

on your Apple Watch to view an 

up-to-the-minute graph of your 

step counts and calories burned, 

plus miles and minutes walked.

Now RecoRDiNG 

After a short animation, 

StepsApp begins recording your 

workout, merging new app data 

with the Health account already 

synced on your device.

acTiViTY TRackeR 

Instead of using watchOS‘s 

built-in Workout app, swipe left in 

StepsApp, find the desired activity 

from the list by tapping on either 

arrow, then tap Start to begin.

how To

Use StepsApp as 
an activity tracker
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B
elieve it or not, the 2017 models of the 

4K iMac are the first updates since the 

original debuted in October 2015; Apple’s 

desktop Macs have had it very quiet of late. 

When it came out, this was a bit of an oddball 

machine. For a lot of people, it ought to be 

a nearly ideal desktop computer – with a 

fantastic, highly detailed display for viewing 

photos or working, the power of a quad-core 

processor, and the inherent advantages of 

a desktop, such as lots of ports and a large 

amount of storage fitted as standard.

But while it was good, the first version 

had its disappointments: It came with a 

slow 1TB, 2.5-inch hard drive, instead of the 

Fusion Drive that always should have been 

the minimum; and its visuals felt a bit 

underpowered, as they were delivered by 

Intel’s integrated graphics chips, rather than 

a dedicated GPU. That was okay for basic use, 

but didn’t give much room for intensive tasks 

that benefit a lot from a powerful graphics 

processor. It was, in short, half-baked.

However, with another 20 months in the 

oven, the 2017 models have risen to a much 

more impressive finish. For a start, you 

can now get a 4K model for less money 

than before. 

When the 4K iMac launched in 2015, it 

cost $1,499, and it was the top-of-the-range 

21.5-inch model, with two non-4K models 

below it. In the 2017 range, there’s the 

equivalent top-of-the-line $1,499 model 

that’s reviewed here, but also a new $1,299 

Retina 4K model.

There’s also an even cheaper $1,099 entry- 

level iMac, which is equipped with just a 

dual-core processor and an integrated Intel 

Iris Plus Graphics 640 processor. Given all 

this, and that model’s 1920x1080 display, 

which lacks the wider color gamut of the 

Retina 4K display, we strongly recommend 

spending at least the extra $200 to get much 

better bang for your buck.

So what do you get for more money? 

Front and center is still the gorgeous Retina 

4K display; at 4096x2304 pixels, it’s actually 

slightly higher resolution than the Ultra HD 

4K broadcasting standard (3840x2160) used 

by regular TVs. This doesn’t mean much in 

21.5-inch iMac with  
Retina 4K display (Mid 2017)
The 4K iMac gets the extra power and speed it deserves
$1,499  From Apple, apple.com

Features 3.4GHz quad-core Intel Core i5 processor, AMD Radeon Pro 560 with 4GB video 
memory, 8GB memory, 1TB Fusion Drive, 2x Thunderbolt 3 ports, 4x USB 3.0 (Type-A) ports, 
SDXC card slot, Gigabit Ethernet, 802.11ac Wi-Fi, Bluetooth 4.2

21.5-inch iMac  
with Retina  
4K display  
(Mid 2017)

	Excellent	4K	display

	Big	graphics	boost…

		…though	still	not	that		
strong	for	the	money

	Divisive	keyboard

GReat 

TOUGH TESTING, TRUSTED RATINGS

VISIT MACLIFE.COM FOR ONLINE-EXCLUSIVE REVIEWS, UPDATED DAILY
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good for gamers, but it’s great elsewhere, 

too – apps from consumer-level stuff like 

Photos to professional software such as 

Final Cut Pro use it to speed up many 

tasks. Skimping on its performance 

meant limiting the capability of these 

apps, but that’s all changed.

Pushing Pixels

Gaming is one of the toughest tests, and 

the difference is huge in our Tomb Raider 

benchmarks. With the game set to render 

at 1920x1080 pixels, we saw a 66 percent 

improvement in frames per second (fps). 

When we set the game to render to the 

display’s native 4096x2304 resolution, 

the difference was a colossal 92 percent – 

though we still only saw 12.3fps on this 

latter test, so don’t expect playable 4K 

games unless they’re a lot less complex 

than Tomb Raider. 

Those results show exactly why we 

were so disappointed with the graphics 

last time, and it’s great to see them fixed. 

This iMac still isn’t blockbuster power for 

a $1,499 machine – it’s not capable of 

powering a virtual reality system, for 

example, which is a shame since Apple 

focused heavily on VR at WWDC – but 

with performance improvements coming 

in High Sierra plus the new breed of apps 

that make better use of graphics power, 

this is a pleasingly capable desktop.

version. (The $1,299 model in this year’s 

range now has a 3.0GHz quad-core i5). 

As is often the case with these 

generational updates, the difference 

between their speeds seems pretty small, 

and practical results bear this out.

In our tests using Geekbench, 

the improvement was a little under 

10 percent for both single-core and 

multi-core operations. When we ran our 

real-world test of a 

difficult video encode, 

we saw around the 

same gain. So, nothing 

groundbreaking, but 

then processor power 

was never a slouch in 

the 4K iMac anyway – 

those are good results 

that match the more 

expensive Retina 5K 

iMac. Even if you’re 

planning to do 

programming or video 

work, this is still a 

strong performer.

The area in which we 

were really looking for improvement 

is graphics. Apple has gone from using a 

thoroughly middling integrated Intel 

graphics processor in the 2015 model to 

a much more capable discrete chip from 

AMD this time around. This is obviously 

practice, yet it’s nice for videographers 

working in the Cinema 4K standard, 

which is 4096 pixels wide. Some DSLRs 

record at this res, so it’s not that obscure 

a thing to want… just pretty obscure.

looking sharP

The important thing is that the display 

is super-crisp for viewing photos, can 

provide a huge amount of working space 

for documents and windows if you tweak 

the settings, supports the P3 wide-color 

gamut to make compatible images 

(including those taken on an iPhone 7) 

look more realistic than on other screens, 

and is now brighter than before. That last 

attribute helps reduce the reflectivity of 

the screen – this year’s models are 

among the best iMacs Apple has made 

for cutting down on reflections – and is 

generally impressive at making 

everything look super-vibrant. Colors 

really pop on this iMac’s display, and 

the sheer number of pixels is brilliant 

for viewing your photos, without the 

slightly monstrous screen size of the 

even-more-detailed 27-inch 5K iMacs.

Next up, the processor: it’s a quad-core 

3.4GHz Intel Core i5, compared to a 

3.1GHz quad-core unit in the previous 

sPeaking oF low-hanging Fruit 
that aPPle has Fixed, you now 
get a Fusion drive as standard

Apple’s aluminum craftsmanship is beautiful, 
but the iMac’s design feels ready for an update.

The display is more impressive than ever, and 
less reflective, thanks to improved brightness.

The 4K iMac remains clean and simple at 
the back, with a central bulge tapering to 
the super-thin edges.

>>>Reviews
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Speaking of low-hanging fruit that 

Apple has fixed, you now get a Fusion 

Drive as standard at this price. It’s a 1TB 

model, and the use of flash storage 

alongside a big hard disk makes a 

massive difference to the experience. 

The fastest data read speed we saw on 

the 2015 model was 104MB/sec; on this 

one it’s 487MB/sec.

A Fusion Drive isn’t as good as purely 

flash-based storage (things you haven’t 

used in a while are slower to find and 

open, since they’re stored on the hard 

disk rather than the relatively small flash 

portion of the Fusion Drive), but it is a 

much, much cheaper way to combine 

the speedy performance of flash with 

the large capacity of a hard disk in a 

single volume – and in a desktop, what 

a lot of people want is plenty of room 

to store photos, videos, and other 

files going back years. That’s what you 

get here, but with a big speed boost for 

apps and files you access often.

Fusion reaction

We’re disappointed to see that the $1,299 

model still only comes with a plain 1TB 

hard drive, though. Apple, this is a 

premium machine, and a little 32GB stick 

of flash storage is not breaking your 

bank – just throw it in! You can configure 

the $1,299 model to have a 1TB Fusion 

Drive for an extra $100, but that’s too 

steep – we would suggest paying an extra 

$100 on top of that to get the best model.

You still get 8GB of memory here, 

which is fine for most people; although 

if you’re delving into editing photos from 

a DSLR, or like to edit video, springing for 

the 16GB or even 32GB upgrade is wise 

even though they’re expensive – you’re 

not able to add more memory yourself 

later, only by going to a service center.

The new iMac models come with 

Apple’s Magic Keyboard, which has a 

fairly crisp response to its keys. It won’t 

win over mechanical keyboard lovers, 

but we like it. That said, we can’t believe 

it doesn’t come with Touch ID in this day 

and age – if you’ve used a new MacBook 

Pro, this will feel like a big backwards 

step. And in the era of thin bezels, we 

think the iMac’s design is due a refresh – 

including a Space Gray option across the 

line, not just on the upcoming iMac Pro, 

Apple! The important thing is that the 

4K iMac gets the internal performance 

to match its fantastic Retina display – 

making this a great desktop pick.

the bottom line. Whether you 

work with photos or videos, or just do 

office work, this is a strong Mac with 

a lovely display. matt bolton

 > what about the imac Pro?
>>> you might be 

wondering whether the 

iMac Pro, due out this 

December, should affect 

your Mac buying decision 

now. It’s a 27-inch 5K 

iMac, but it’s quite a 

different beast to the 

regular 5K iMac (which 

we’ll have a full review 

of next issue).

It has the same bright, 

wide-color display as the 

4K and 5K iMacs in the 

same chassis (except it 

comes in Space Gray), 

but with Mac Pro-level 

innards, hence the 

name… and the price: 

it starts at $4,999, rather 

than the $1,299 of the 

4K iMac. Its processor is 

eight-core at minimum, 

rather than quad-core, 

and can be configured 

10 or 18. It can take up to 

128GB of memory, and its 

graphics card is made for 

high-end 3D rendering, 

not a quick bit of 

Civilization VI.

In short, the iMac 

Pro is a beast, and put 

simply, if you have to 

ask whether it’s for you, 

it’s almost certainly not. 

It’s for people who know 

they need all that power. 

Don’t let the fact that it’s 

coming later this year 

put you off buying a 

suitable iMac now.

The ports are generally identical to before, but with 
Thunderbolt 3’s ludicrous speed and 5K display output.

The 4K iMac gives you a big, crisp display, 
without dominating your desk the way the 
27-inch model (with Retina 5K display) does.

Tough testing, trusted ratings
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MacBook 
(Mid 2017)

	Highly	portable

	 Improved	keyboard

	Very	fast	storage

	One	power/data	port

Great 

A
pple hasn’t changed the ultra-slim 

MacBook much in the little over two 

years since the computer’s 2015 debut. 

A glance down the tech specs for the 2017 

version reveals a lot of things are unchanged, 

for better or worse: the FaceTime camera 

still captures a 480p picture; there’s still 

a 3.5 mm headphone jack on the right side; 

and – as you probably expected – Apple 

hasn’t shifted on its single-port design.

Storage capacities are also unchanged 

from 2015 and 2016 models, but when you 

compare the amount that’s provided in 

$1,299 models of MacBook and MacBook 

Pro, that isn’t cause for concern. With the 

MacBook, Apple is generous – not merely 

because you get twice as much storage as 

in the Pro, but also because it has boosted 

the speed by up to 50 percent for the 2017 

refresh, which was borne out in our tests.

Where the MacBook’s processing capability 

is concerned, though, we weren’t expecting 

much given that its fanless design imposes 

constraints on what components can be used 

in the ultra-thin body without overheating.

But Intel’s processor optimizations in 

the two years since 2015’s MacBook show 

headway is being made – even if the low-end 

Core m3 naturally can’t hold a candle to its 

Core i5 brethren, at faster clock speeds, 

used in the 13-inch MacBook Pro. So, our 

CPU-intensive HandBrake test completed 

17 minutes more quickly on the entry-level 

MacBook as compared to 2015, thanks to 

two generations of architectural tweaks 

and a slight boost in clock speed.

The MacBook is improving more slowly 

where graphical capabilities are concerned, 

as shown by our Batman: Arkham City tests, 

which is now a fairly old game. Another big 

sticking point with the MacBook for many 

people has been its keyboard, so as part of 

this year’s refresh, Apple has improved the 

overall feel when typing by adding its 

second-generation butterfly key mechanism. 

One thing makes this generation more 

appealing than anything else we’ve talked 

about: being able to get 16GB of memory as 

a $200 build-to-order option. If you happen 

to push the MacBook hard now and then with 

large photos, or just by leaving lots of apps 

open, this is a very welcome change.

We still can’t ignore the awkwardness of 

having to unplug power to connect storage 

or some other accessory. For many people 

that won’t matter at all, but if you have to 

plug in a hard drive to back up with Time 

Machine, it forces you to spend on adapters.

the bottom line. If power is what you 

mostly (or only ever) connect, and you like 

the new keys, this is a great portable Mac. 

AlAn stonebridge

MacBook (Mid 2017)
Looking for a refresh? Look this way…
$1,299  From Apple, apple.com

Features 1.2GHz dual-core Intel Core m3 processor, 8GB 1866MHz LPDDR3 memory,  
256GB SSD storage, Intel HD Graphics 615 processor

>>>Reviews
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S
ince the end of last year, there have 

been two major attributes that define 

the high and low end of the MacBook Pro 

line-up. Aside from screen size (and thus 

weight), you must choose between high-end 

models with a Touch Bar and low-end ones 

with traditional function keys. With the latest 

refresh coming just seven months later, that 

distinction persists.

The model reviewed here is of the latter 

type, and though it offers a slower Intel Core 

i5 clock speed than its more costly siblings, 

its memory spec is now in line with them, 

risen from last year’s 1866MHz to 2133MHz. 

16GB remains the maximum memory capacity 

you can get, as a $200 build-to-order option.

Additionally, all MacBook Pros have been 

refreshed with seventh-gen (Kaby Lake) Intel 

Core i5 processors, and newer Intel Iris Plus 

Graphics processors – a 640 in function key 

models, and a 650 in those with a Touch Bar. 

CPU clock speeds have been upped across 

the line-up too, with our review unit boosted 

from its predecessor’s 2.0GHz to 2.3GHz. 

Stepping up a generation to Intel’s Kaby 

Lake processor architecture delivers bigger 

gains from the CPU than the integrated GPU. 

Our HandBrake test finished seven minutes 

sooner than the outgoing model, even 

beating last year’s 13-inch, 2.9GHz MacBook 

Pro with Touch Bar by a slim margin. 

However, the GPU performed barely any 

differently in our Tomb Raider benchmark 

than last year’s Iris Graphics 540.

On both function key models, benefits from 

the 2016 line-up still apply. Perhaps the most 

appealing is the Retina display‘s 500-nits 

brightness and wide color (P3) gamut, which 

are delightful if you snap wide-color photos 

with an iPhone 7, because you can see more 

colors and edit them accurately on this Mac.

In all, you’d have to be very keen on the 

Touch Bar, two extra Thunderbolt ports, and 

perhaps the better GPU to easily justify 

dropping $1,799 on the next model up. Having 

two ports is fine for lighter demands such as 

a printer, a USB flash drive, or your iPhone, 

not necessarily all connected at once.

the bottom line. A good Mac, but the  

expected gains of Kaby Lake can’t overcome 

our concerns about cost. 

AlAn Stonebridge

MacBook Pro  
13-inch (Mid 2017)
A good alternative to a 13-inch MacBook Air 
$1,499  From Apple, apple.com

Features 2.3GHz dual-core Intel Core i5 processor, 8GB memory (2133MHz 
LPDDR3), 256GB SSD storage, Intel Iris Plus Graphics 640, two Thunderbolt 3 ports

MacBook Pro  
13-inch (Mid 2017)

	Compact	and	light

	Good	battery	life

	 	Kaby	Lake	benefits	
intensive	tasks

	 It	costs	a	lot

solid 

>>>Reviews
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T
here’s an adage for most new tech: don’t buy the first version. 

No matter how groundbreaking and good it is, the second will be 

even better. And so it has come to pass that the smaller ipad pro’s 

second version leaves its predecessor looking like an unfinished thought.

With its eye firmly on the “pro” side, Apple has improved things in 

three key areas from the 9.7-inch ipad pro: the amount of working space, 

the quality of the display, and the performance. The move to a 10.5-inch 

screen with a higher resolution of 2224x1668 pixels adds about 20 

percent display area, while keeping the same sharp pixel density – and 

barely any extra size to the chassis, due to the new design.

Items on the screen generally look the same size as on the 9.7-inch 

model, but you have more space to play with, and it allows for extras – 

such as the on-screen keyboard (and separately purchased Smart 

Keyboard) being just about full-size, which helps with typing speed. 

It’s subtle overall, but instantly obvious if you work in Split View a lot. 

It was usable but a little cramped before; now we find we can happily do 

all kinds of work with our email app locked to a quarter of the screen.

Of course, the 12.9-inch ipad pro is even more comfortable for working 

in Split View, and will be the best platform if you want to use four apps 

simultaneously (coming in iOS 11), but the 10.5-inch display here is now 

a wonderful balance between space and portability. 

But size isn’t the only interesting change to the display. One big feature is 

support for a 120Hz refresh rate, which doubles the number of frames per 

second the screen shows compared to Apple’s previous displays. It makes 

animations look extremely smooth, and scrolling text more readable. This is 

lovely but, more importantly, it also makes the screen twice as responsive, 

because it shows the result of any interactions twice as fast. That’s huge in 

the case of the Apple pencil. 

10.5-inch iPad Pro
Apple‘s tablet gets a second wind 
From $649  From Apple, apple.com

Features 2224x1668-pixel display, A10X processor, Lightning port, 
Smart Connector, Apple Pencil support, up to 512GB of storage

10.5-inch 
iPad Pro

  Amazing display

  Hugely powerful

  Great battery life

  Still super-portable

awesome 

Tough testing, trusted ratings
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The display is powered by ProMotion tech, 

which varies the refresh rate; if you’re watching 

a TV show or reading a book, the screen runs at 

a lower rate to save power. This is all essentially 

unnoticeable, but results in excellent battery life: 

We typed this review for a couple of hours, spent 

another hour browsing the web and viewing 

photos, then left it on standby overnight – and the 

battery was still at 80 percent the next morning, 

so ProMotion seems to do its job.

The screen’s brightness has been amped up, 

too. Combined with the wide color gamut, it 

makes photos look astoundingly vibrant, and 

helps with viewing in bright light, in conjunction 

with an improved anti-reflective coating. It’s even 

good enough to display high dynamic range 

(HDR) video, though support for this won’t arrive 

until iOS 11. The 2017 iPad Pros have 

Apple’s best screens to date.

There’s another huge boost when 

it comes to the iPad Pro’s sheer, raw 

computing power. The new A10X 

processor is a triple-core chip (up 

from the dual-core A9X), with 4GB of 

memory and a new, more powerful 

graphics unit. Opening and switching 

between apps is very fast, but other 

iPads don’t feel slow in comparison. 

It’s in intense tests that you see its 

power: in Geekbench 4, the A10X 

scores 81 percent higher than its 

predecessor, and 42 percent higher 

than the latest generation of 12-inch 

MacBook. In fact, its score even beats 

most 13-inch MacBook Pro models.

In real-world tests against its 

predecessors, you’ll see less dramatic 

results, but still considerable gains. 

To test the processor, we used WinZip to 

compress a 1.2GB folder of files, and the new Pro 

finished the task in 25.16 seconds – 37 percent 

faster than the 39.93 seconds of the 9.7-inch Pro.

Not many apps use this much power now, but 

it helps futureproof this machine as more and 

more powerful apps appear. Take Affinity Photo, 

which is basically the equivalent of Photoshop on 

the iPad. On the old Pro, it works great, but with 

some pausing after you apply certain brushes. 

There’s no such waiting on the new iPad Pro.

There are improvements for pros in other 

areas too, such as up to 512GB of storage, and 

USB 3 support over the Lightning port. The Pro’s 

speakers are still great, and the Smart Connector, 

though unchanged, is handy for things like the 

Smart Keyboard (which still costs an eye-watering 

$159 – wait for a cheaper option if you can). 

So, should you get this iPad? Absolutely – 

if you’re looking for a portable work machine. 

If you just want an entertainment tablet, its HDR 

support is great, but it’s very much overkill – the 

fifth- generation 9.7-inch iPad is almost half the 

price, and fantastic for non-pro stuff. But with its 

gorgeous display, oodles of power, and amazing 

drawing prowess, this really can be a laptop 

replacement for some. In fact, it might just be 

our favorite computer in years.

The BoTTom Line. A stunning display and 

powerful futureproofing make this a top mobile 

working machine – and it’ll only get better when 

iOS 11 is released. maTT BoLTon

The new A10X processor 
and graphics performance 
improvements provide 
real pro power.

The 120Hz ProMotion 
display makes the Apple 
Pencil feel more fluid 
and realistic than ever.
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T
hese Lightning headphones solve a problem 

that iPhone 7 users have been dealing with 

for a year now – how to listen to wired 

headphones and charge your phone 

at the same time. Here, it’s easy. You plug their 

Lightning connector into your device, then plug 

power into them, and you’re all set. Of course, 

Lightning means they only work with suitably 

equipped iOS devices.

But that’s not all these headphones do. 

They’re packed with extra smarts that make 

them great headphones even beyond 

that feature. There’s active noise 

cancellation that rivals the Bose 

QuietComfort range – our gold 

standard – for cutting out sound, 

plus a very smart auto-muting mic 

feature that cuts out all sound from 

your end of a call when you’re not talking, 

so the other person doesn’t have to talk over 

background noise. They also auto-pause your 

music when you take them out of your ears, 

Pioneer Rayz Plus
Clever and capable cabled headphones
$150  From Pioneer, pioneerrayz.com

Features Lightning connector, passthrough Lightning port, HearThru ambient sound mode

Pioneer 
rayz Plus

	Great	sound	quality

	 Intelligent	behaviors

	Charge	while	listening

		Not	the	most	
natural	sound

awesome 

just like Apple’s AirPods. The Rayz app includes 

the ability to set the action of the inline remote’s 

Smart Button to toggle noise cancellation, mute/

unmute calls, or open an app of your choice.

The headphones come with a wide range of 

in-ear tips to make sure you get the best sound 

out of them too, which is great, since they don’t 

skimp on audio quality either. 

The sound is pretty punchy, filling the mid 

and bass with richness, without forgetting to 

pack the high end with detail and precision. 

Those who are particular about a very 

open and natural sound won’t find 

them totally to their taste, but we 

think just about everyone else will 

love them, especially for the price.

the bottom line. Charge and 

listen at the same time, enjoy great 

sound, and count on top-notch noise 

cancellation. A top buy for your iPhone 

if you don’t mind wired headphones. 

matt bolton
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The Mac’s Spotlight search engine has added lots of new 
features in recent years, but as a tool for searching your 
computer, it remains basic.

That’s where HoudahSpot comes in. It uses the Spotlight 
index but allows you to build searches using a variety of 
criteria and save them as templates, somewhat like Smart 
Folders. And it’s mighty fast. It comes with lots of prebuilt 
templates; new in version 4.2 is one that enables you to 
search for all video files of HD resolution on your Mac.

While HoudahSpot presents an interface that may seem 
daunting, selecting a template from the Templates menu 
quickly reveals the app’s power and ease of use. So, for 
example, choose Mail and you’ll see a list of search criteria 
in the left-hand sidebar. You simply fill in the ones you 
want to inspect and press “play” – it’s that easy.

Once you’ve pinpointed what you want, you can double-
click to open it in the specified app; open it in another app; 
or tag, rename, copy, or move it. It’s powerful stuff.

The boTTom line. HoudahSpot is ideal for anyone who 
craves more powerful searching than Spotlight in macOS. 
kenny hemphill 

Mac compression utilities aren’t sexy — if they 

reduce file sizes and use less bandwidth, it’s a job 

well done. Corel brings some of the sizzle back in 

WinZip 6 for Mac, which now manages files as well 

as compacting them.

This is done from a new Files pane on the app’s 

left-hand side, where you browse mounted 

volumes, cloud storage accounts, and the last five 

archives accessed. Rather than dragging and 

dropping from Finder or using the Action menu, 

everything happens inside WinZip’s window, 

with the pane expanding into split-screen view 

alongside the current archive while browsing.

WinZip isn’t quite a full-fledged file manager — 

you can’t view two volumes side-by-side, for 

example — but the improvement will be welcome 

if you work with Zip, GZip, LZMA2, BZip, and other 

archive formats. Contextual menus provide a 

convenient peek without opening files, and you 

can delete and rename files from within the app. 

There’s also enhanced support for Zipx.

The boTTom line. More convenient than 

ever, but no upgrade pricing. J.R. bookwalTeR

HoudahSpot 4
Turning up the Spotlight power
$29  From Houdah Software, houdah.com

needs OS X 10.10 or later

WinZip 6 for Mac
Surely that’s “MacZip” then?
$29.95  From Corel, corel.com

needs OS X 10.8 or later

HoudaHSpot 4.3

	Powerful	search	tools

	Can	build	custom	search	templates

	Very	granular	control

	 	May	seem	daunting	at	first

ExcEllEnt 

WinZip Mac 6

	Convenient	new	Files	pane

	One-click	access	to	local	and	cloud	volumes

	Zipx	support

	No	upgrade	pricing

Good 

Tough testing, trusted ratings
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Screens 4 enables you to connect to your 
Mac from anywhere there’s an internet 
connection. Once connected you can control 
the Mac remotely as if you were sitting in 
right front of it.

Version 4 adds the ability to transfer files 
by dragging and dropping between your local 
Mac and the remote one, as well as a feature 
that obscures the display of the remote Mac 
while you work. 

If you connect to a Mac with multiple 
displays attached, you can choose which of 
them you want to view, or see all of them at 
once. And if you connect to multiple Macs, 
you can save them and arrange them in 
groups to help you find them easily later.

Setting up Screens is straightforward. 
On a local network Macs are automatically 
detected, though you’ll need to switch on 
Screen Sharing in a remote Mac’s System 

Screens 4
Get at your Mac on the move
$29.99  From Edovia, edovia.com

Needs OS X 10.11 or later

ScreenS 4

	Easy	to	set	up

	 	Drag	and	drop	files

	 	Can	obscure	screen	
of	remote	Mac

		Occasional	glitches	with	
file	transfers/Clipboard

Great 

Preferences to control it. To connect over 
the internet, you need to set up a Screens 
account and run the Screens Connect utility 
on the Mac you want to connect to.

We found Screens worked well, and 
connected quickly over our local network. 
For the most part it worked exactly as it 
should. However, we did run into occasional 

problems when trying to drag and drop files 

between our local Mac and the one we were 

connected to. Likewise, we sometimes ran 
into problems copying and pasting between 
remote and local Mac. Those problems could 
have been down to our network, however. 
Other than that, we found Screens to be a 
snap to set up and a pleasure to use.

The BoTTom LiNe. If you need to 
connect to a remote Mac, for whatever 
reason, Screens 4 is a great way to do it. 
KeNNy hemphiLL

You can group multiple 
Macs and view them 
as thumbnail images to 
make locating the one 
you want easier.
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Currently you have few good options on a Mac for creating 
pro-level video discs on a budget. Final Cut Pro X and 
Compressor can create basic discs, but offer prosumers 
who want to sell content on physical media little in the 
way of real authoring capabilities.

Despite its name, neither does Corel’s new MyDVD Pro, 
but this is otherwise a perfectly affordable solution for 
everyone else. Essentially a stripped-down version of Roxio 
Toast, MyDVD Pro makes it easy to create DVD or AVCHD 
discs in a few clicks, with a Blu-ray option also available 
for a one-time in-app purchase of $9.99.

MyDVD Pro includes 13 consumer-themed menu 
templates, but you can customize text, colors, backgrounds, 
and music. The dark interface offers intuitive navigation for 
choosing themes, importing media, or creating manual or 
automatic chapter stops. Encoding quality is good, but you 
have zero control over the results.

Two features appeal to pros: You can share from Final Cut 
Pro X with imported chapters, and save disc images in the 
popular ISO format, rather than Apple’s own IMG type.

The boTTom line. Hardly pro, but perfectly acceptable 
for burning consumer discs. J.R. bookwalTeR

When it comes to saving YouTube content to iOS 

devices, few apps do it as eloquently as this one. 

Copy a web address and this one-click Mac app 

downloads, converts, and imports videos to your 

iPhone or iPad. And that’s merely the opening act.

With YouTube Converter 2, iOS devices no 

longer need to be tethered by a cable — the 

whole process can now happen over Wi-Fi, with 

no impact on transfer speed. The software is four 

times faster than before, with support for 4K, 

high frame rate, and even VR, 360-degree videos.

Although the first version could download from 

a few other sites like Vimeo, SYC 2 handles over 

30, including Vevo, Bandcamp, and Discovery 

Channel. By enabling a preference, downloads 

also include subtitles when available.

Creating ringtones with one click is another 

killer feature, with a few caveats. You can choose 

an entire song or only the first 30 seconds, but 

there’s no way to trim to your favorite section. 

The boTTom line. Bugs aside, a must-have 

utility for all iOS users. J.R. bookwalTeR

MyDVD Pro
A somewhat specious title
$19.99  From Corel, corel.com

needs OS X 10.11 or later

Softorino YouTube 
Converter 2
From YouTube to your device
$19.95  From Softorino, softorino.com

needs OS X 10.10 or later, iOS 5 or later

mydvd pro

	Customize	text	and	backgrounds

	 	Too	basic	for	prosumers

	 	No	encoding	controls

	 	Limited	authoring	functionality

okay 

Softorino youtube Converter 2

	Download	web	videos

	Transfer	via	Wi-Fi

	Device	transfer	bugs

	Falls	into	legal	gray	area

Great 

Tough testing, trusted ratings
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E
verything is a simulation of sorts. You play as a wayward consciousness, 

hopping from one host to the next. The point of the “game”, if there must 

be one, is simply to explore. Perhaps you start off as a muskox – braying, 

leading your herd, and reproducing. Eventually, a buzzing housefly, a creaking 

oil rig, or even a wandering asteroid will lay out Everything’s guiding principle: 

“This isn’t about giving you something to see, but giving you a different way 

of seeing.”

Initially, you can only hop into other vessels of similar size, but Everything 

treats ecosystems like a collection of infinitely nested Russian dolls: there’s 

always a smaller or larger level to explore, from ox to flea to paramecium.

Squeeze into a grain of sand and the camera pulls in tight, until wood 

splinters and grass stalks scrape the sky; spend a few seconds as a lenticular 

galaxy and realize there is something even bigger to investigate. Eventually, 

you’ll be able to simply will things into existence, no matter where.

All the while, the world around you teems with other creatures’ inner 

thoughts: jokes, reflections, and laments. You may meet a giraffe who falls 

in love too quickly, or an underwater strand of kelp unsure if it will survive 

the day. Sometimes, you’ll hear snippets of mid-century lecturer Alan Watts 

explaining his notion of cosmic interconnectedness. Leave the keyboard alone 

for more than a minute and Everything plays itself, zipping up and down the 

great chain of being with ease, a guided tour of all creation.

Infused with a sense of wonder and awe, Everything’s charm is in the sheer 

volume required to live up to its name, in the way it crams life into each nook 

and cranny: there is always something new to discover, some joyful 

juxtaposition to stumble across. To meet such technical demands, Everything 

adopts a lo-fi aesthetic that only amplifies its potential for serene beauty and 

absurd comedy.

Despite Everything’s philosophical underpinnings and O’Reilly’s roots as 

an experimental artist and filmmaker, Everything isn’t precious or opaque. 

Its novelty and boldness drive the game’s first several hours until a series of 

puzzles take shape.

The boTTom line. As Everything’s mechanics reveal themselves and 

boundaries disappear, a more recognizably game-like objective emerges: to 

fill in the games’s overflowing encyclopedia, from Arctic fox to zebra, amoeba 

to quasar. Interesting, if too unguided for some tastes. Joseph leray

Everything
Turns out you can have it all
$14.99  From David O’Reilly, everything-game.com

needs OS X 10.8 or later

EvErything

	 	Refreshingly	novel

	 	Exploration	is	
consistently	surprising

	 	Thought-provoking	but	
not	preachy	or	dense

		Lack	of	clear-cut	goals	
might	be	turn	you	off

grEat 

>>>Reviews

66  	SEP 2017	 	maclife.com



Tough testing, trusted ratings

 maclife.com 	SEP 2017	   67



here have been plenty of 
headlines about air pollution in 
recent months – including the 
news that the Environmental 

Protection Agency has proposed delaying 
a federal air pollution rule for two years. 
Air quality isn’t just the responsibility of 
governments, though, especially when it 
comes to indoor air quality, which now has 
its own acronym: IAQ. After all, most of 
us spend most of the day – and night – 
indoors, so indoor air quality can obviously 
have a major effect on our health.

That’s why a number of companies have 
developed air quality monitors that can 
detect and measure a number of different 
pollutants and other factors and, in effect, 
tell us when to open a window and get some 
fresh air. That might seem like simple 
common sense, but not all pollution is easy 
to detect. Some factors – such as humidity – 
can be quite harmless for many people, but 

> get started with…

Indoor air quality can affect your health, 
decision-making, and learning – so take 
control with these new air monitors

t

Better living through smarter technology

home liFe

air quality 
monitors

By cliFF JosePh

>>>Home Life
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have a real impact on others who suffer from 
allergies or medical conditions such as asthma.

The simpler air quality monitors tend to 
concentrate on the level of carbon dioxide (CO2), 
which is often used as a ballpark indication of 
indoor air quality. Netatmo’s Healthy Home Coach 
is a good example, and has actually been available 
for a few years. Priced at $100, the Home Coach 
focuses on CO2 levels, as well as monitoring 
temperature and humidity. It can check sound 
levels too, although that doesn’t exactly seem 
essential to us.

something in the air

Like most air quality monitors designed for 
home use, the Home Coach can simply flash 
a few warning lights to get your attention when 
it thinks there’s a problem, but it can also connect 
to your home Wi-Fi network to send you 
notifications and detailed 
info via its companion app 
on your iPhone.

The next step up is a device 
such as Elgato’s Eve Room, 
which is actually cheaper at 
$80, but also has the ability to 
monitor VOC – volatile organic 
compounds. That term covers 
a wide variety of airborne 
chemicals and pollutants, 
from – ironically enough – 
air fresheners, to burnt food, 
cleaning materials, or the 
emissions from an office 
printer (a contributing factor 
to “sick building syndrome” 
in many large office blocks).

However, the Eve Room 
relies on Bluetooth, rather 
than Wi-Fi, to connect to the 
Eve app, which helps to keep 
the price down but also means 
that you’ll probably have to be 
in the same room in order for 
the two to connect. Despite 
their relatively low prices, the 

W e ’ r e  s ta r t i n g  to  s e e  Fa n s , 

a i r  c o n d i t i o n e r s ,  a n d  m o r e 

t h at  W o r k  W i t h  h o m e k i t

Awair is designed 
to blend in with 
your home.

The Foobot’s looks aren’t 
the most discreet, but it 
has a modest footprint.

>>>Home Life
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Eve Room and Netatmo Healthy Home Coach both 
support Apple’s HomeKit software. This means 
that you can use Siri voice commands to get a quick 
air-quality report, or even use them to control 
other HomeKit devices, such as Netatmo’s Starck- 
designed smart thermostat. If the monitor thinks 
it’s too warm then HomeKit – along with the Home 
app in iOS 10 – would allow it to turn the heating 
on or off. We’re also starting to see humidifiers, 
air conditioners, and fans that work with HomeKit, 
making it easy to control those, too.

dust to dust

Going one step further, the best 
all-round indoor air quality monitor 
that we’ve seen so far is the new 
Foobot (Model 21) from AirBox 
Labs. It’s a little pricey at $199, 
but the Foobot really goes to 
town with sensors that allow it 
to monitor both carbon dioxide 
and carbon monoxide, VOCs, 
temperature, and humidity. Its 
outstanding feature, however, is 
its ability to detect “particulate 
matter” – fine particles that can 

include dust, aerosol sprays, smoke, and other 
pollutants. These particles are small enough to 
penetrate your lungs and cause a variety of health 
problems, or exacerbate existing allergies and 
other conditions.

The sheer amount of data recorded by the Foobot 
means that its iPhone app can sometimes blitz you 
with statistics but, like most of its rivals, it has a 
simple system of color-coded warning lights that 
can flash to get your attention. 

Another new option that is very similar to the 
Foobot is Awair, which also costs $199. We haven’t 
had a chance to take a close look at this yet, but it 
claims to monitor CO2, VOCs, temperature and 
humidity, dust, and particulate matter. It has 
a neat retro design too, like an old wireless radio.

Finally, there’s one clever jack-of-all-trades 
that is also worth mentioning. 

The Withings Home camera is a 
popular baby monitor, but also 
has the ability to monitor VOC 
levels in a child’s bedroom. It 
costs $290, but the combination 
of a baby-cam and air quality 
monitor in one device will 
appeal to many parents who 
want to keep a close eye on their 
child’s health.

Foobot is one of the few monitors to 
detect particulate matter, such as smoke.

Elgato’s Eve Room 
can monitor volatile 
organic compounds.
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We recommend the best air quality monitors for use at home

elgato eve room

$80

elgato.com

> The most affordable air 

monitor around at the 

moment. Its Bluetooth 

connectivity is a tad 

limiting, but it gives a good 

indication of general air 

quality by measuring CO2, 

VOCs, temperature, and 

humidity. It also supports 

Apple’s HomeKit tech, 

so you can control it using 

Siri voice commands.

1 2 3 4
netatmo healthy 

home coach

$100

netatmo.com

> Its features might seem 

somewhat basic, 

concentrating mostly on 

CO2, temperature, and 

humidity, but the Healthy 

Home Coach is easy to use, 

and its HomeKit support 

means you can link it with 

other HomeKit devices, 

such as to a thermostat 

to control your heating.

aWair

$199

getawair.com

> The Awair monitor has 

a smart retro design that 

should blend in with most 

home decor, and its front 

panel acts as a simple 

display so that you can 

quickly check air quality 

without having to use its 

iPhone app. Awair is able 

to check for CO2, VOCs, 

temperature, humidity, 

and dust particles.

FooBot (model 21)

$199

foobot.io

> Though more expensive 

than some of its rivals, 

the Foobit is one of the 

most sophisticated indoor 

air-quality monitors you 

can get right now. It can 

measure CO2, VOCs, 

temperature, and humidity, 

as well as detecting fine 

particles that can get into 

your lungs and cause 

serious health problems.

 Five oF 
the Best
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nokia home

$290

health.nokia.com

> Nokia’s Home security 

camera is a good option 

for parents. It’s best known 

as a baby-monitor camera 

for parents who want to 

keep an eye on their 

sleeping toddlers, but 

Home also includes

a sensor that can monitor 

VOCs in order to check on 

air quality in potentially 

stuffy bedrooms.

5

A 
PPle’s WWdc event may 
have saved my marriage, 
with the announcement 
of new developments in 

geofencing. There’s a sentence 
I never thought I’d type into a 
Google Doc, but hey, it’s 2017, 
politics has gone nuts, and 
apparently you can eat Pop Tarts 
without toasting them first – 
so let’s just accept the new 
reality and move on.

My husband loves geofencing. 
Loves it. When he leaves the 
house, all the lights go off. As his 
car pulls back into the drive at 
night, a tree of twinkling fairy 
lights blossoms and welcomes 
him home. When he climbs into 
bed and says “Goodnight” to Siri, 
the house falls into darkness save 
for a small nightlight in our 
daughter’s room. Sometimes he 
talks wistfully of the day that our 
Eve Motion sensor will inform us 
of movement in our attic when 
we’re both out, rather than when 
I charge up there to chase an 
overconfident bat. Although why 
that’s a dream scenario I really 
have no idea.

This is all fine and dandy, 
except that our geofencing is 
tied to his devices. So for the 
first week after setting it up, and 
intermittently since, the child 
and I find ourselves alternately 
plunged into darkness, confused 
by a nightlight, or startled by a 
tree. My nerves are now 
completely shot.

But hope, like a toddler caught 
in the dark on a potty, springs. 

Apple’s WWDC keynote this year 
announced an update to HomeKit 
to allow multiuser geofencing. 
So soon the house will only go 
dark if both my husband and I are 
out, and will be lit again when the 
first of us returns. Hooray! Great 
news for everyone, except the 
kid, but hopefully she won’t be 
leaving the house alone any time 
soon. Hey, Apple, geofencing for 
kids, WWDC 2018? See you there!

To her chagrin, JenniFer Phin 
is newly excited about geofencing

>smart home living 
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This colorful educational fishing 
adventure takes place in the 
fictional Mingoville Lake District, 

where Fisherman Fred is your guide through a 
variety of “lakes,” each in a different category, 
such as animals, family, clothes, or food.

Only the first category is unlocked in the free 
version – you’ll have to pony up $0.99 for a 
“fishing license” to each additional lake, or pay 
$2.99 to get them all. The objective is to sit in a 
boat and fish for the letters required to spell 
each word as they swim by. There are more than 
500 words in total, and everything has been 
designed for a child’s short attention span.

The graphics are fun and quite good, with 
plenty of eye-catching color, animation, music, 
and voice actors along the way. Fish and Spell’s 
gameplay also helps improve hand-eye 
coordination and reflexes. Each level offers easy, 
medium, and hard options, so kids aged 5+ will 
have plenty of challenges. J.R. BookwalteR

Fish and Spell
Gone fishin’
Free

TV Deluxe
Live TV – if you’re lucky
$4.99

Can you really get the likes of the Disney Channel and Fox HD for free using 
this app? If you’re raising an eyebrow right now, you know the answer…

If only real fishing was this lucrative. Still, at least your child 
will be learning to spell while you count the coins.

If the lure of 
500 premium 
channels for a 

one-time purchase of five 
bucks sounds too good to be 
true, well… it is. TV Deluxe 
makes bold claims about 
bringing live TV channels 
to your Apple TV – even 
touting “the highest 
number of TV channels in 
all the App Store” – but you 
get what you pay for.

First of all, don’t expect 
to fire this app up and start 
watching feeds from the 
four major networks. 
The majority of TV Deluxe’s 
content comes from 

publicly available web 
streams or questionable 
online sources like FilmOn, 
but it ultimately depends 
on what you’re looking for.

We found foreign 
channels to be more reliable 
– many American sources 
failed with a prompt that 
“an error occurred loading 
this content.”

You can also add your 
own channels in .m3u8 
format, but it’s a bit of a 
chore from the TV, and the 
developer’s universal 
iPhone/iPad app requires 
a separate purchase. 
J.R. BookwalteR

>>>Home Life
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Check out the best of wild country life with 
the air con on full blast, and an iced tea. 

There are a lot of sports-related vistas 
on offer, though that’s to be expected.

VIZIo SmaRtCaSt  

m-SeRIeS m65-D0

$1500 • Vizio.com

For the Android-curious, this 
65-inch Ultra HD, HDR-capable 

display includes a six-inch 
tablet remote powered by 

Google’s mobile OS, offering 
both HDR10 and Dolby Vision 

for good measure. It’s also quite 
affordable, with ample ports 

and decent image quality – but 
where’s the Amazon Video app? 

NytStND tRay 5

$89 • nyTsTnd.com

Why buy multiple chargers 
when one can handle 

everything you own, including 
Apple TV’s Siri Remote? This 

all-in-one dock is equipped for 
iPhone 5 or later, any iPad with 
a Lightning port, Apple Watch, 
and AirPods, and has a holder 

for your Apple Pencil too. 
It comes in white or black with 
a choice of three base colors.

make the most of 
home entertainmentNo matter how much 

one loves the great 
outdoors, at some 

point you need to enjoy the spoils 
of home life. But that doesn’t 
mean you can’t get a quick fix of 
the outside, courtesy of Apple TV 
and the Outside TV Features app. 

This app offers more than 4,000 
curated short-form videos 
showcasing action and adventure 
sports content from Outside TV 
Network, and the app has also 
recently expanded into full-length 
feature films and original series, 
courtesy of a $4.99 per month 
premium subscription.

Content is high-quality and easy 
to find, complete with access to a 
live feed from the network and the 
ability to queue favorite videos to 
enjoy later. There’s a seven-day 
free trial too. J.R. BookwalteR

Twitter might not 
seem like the most 
obvious app for Apple 

TV, but the new 7.0 update has 
done more than just put a fresh 
coat of paint on the smartphone 
and tablet version. That’s because 
the big-screen edition now enables 
you to view live 360-degree videos 
on your television screen.

Twitter for Apple TV also now 
taps into the Periscope Global Map, 
so you can easily find user-created, 
livestreaming content from all over 
the world. Although video quality is 
fairly low-resolution in live 360 
mode, controlling the view with the 

Siri Remote’s touch pad is pretty 
neat. However, it’s just a little too 
easy to accidentally tap and call up 
Report Broadcast while viewing, 
which could hide the content being 
viewed. J.R. BookwalteR

Outside TV Features
The great outdoors, indoors
Free (subscription required)

Twitter
Live 360-degree views from your social feed
Free

Better living through smarter tech
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There are at least two good ways to do 

this. DVDs are really just a bunch of 

data files, and you can move those to 

your Mac either via DVD – if it has an 

optical drive – or by copying them from 

your PC to a memory stick or other 

storage. Once on your Mac, you can 

view them using DVD Player.

In that app, choose File > Open DVD 

Media. Select the VIDEO_TS folder on 

the DVD, or in the folder to which you 

copied the disc’s contents on your 

memory stick, and the app should load 

and play the video as normal.

FireWire still burning?
Can I connect a FireWire camera 

to a MacBook from 2016? Yep, it’s 

a pretty old model of camera…

Yes, but it takes two adapters 

whichever way you do it. One route is 

from USB-C to USB 3, then connect a 

USB 2-to-FireWire adapter. Your other 

option starts with a Thunderbolt 3 

(USB-C) to Thunderbolt 2 adapter, 

then Thunderbolt 2 to FireWire 800.

The App Store is stuck
Why can’t the App Store seem to 

load any data for updates?

Move its settings at ~/Library/

Preferences/com.apple.commerce.plist, 

/Library/Preferences/com.apple.

commerce.plist, and ~/Library/

Preferences/com.apple.appstore.plist 

to your Documents folder. Then sign in 

to the App Store from scratch. If you 

still can’t get it to check properly for 

updates, contact Apple Support so it 

can check your account if necessary.

Put it right there
Can I force an iOS app to store its 

data locally?

It varies, but in many cases you can. 

The exception is if the app needs 

iCloud to function, which a lot of the 

time is offered just as a way to access 

files from all your devices. In Settings > 

[Apple ID] > iCloud, turn off an app’s 

switch under “Apps using iCloud” to 

block it from using that service.

Aware of ransomware
Given the recent spate of 

ransomware attacks around the 

world, I’m wondering if macOS 

protects against ransomware?

System Integrity Protection (SIP) 

in El Capitan and Sierra should stop 

To play a DVD from non-optical storage, such as a memory stick, in DVD 
Player choose File > Open DVD Media and point at its VIDEO_TS folder.

I used to create slideshows on Windows PCs using Photodex 
ProShow software, then burn them to DVDs. Now I’ve 
switched to a Mac, how can I best transfer those?

ACCeSSInG PC SlIdeShOWS

You can also “rip” homemade DVDs 

to a more convenient format using one 

of the many ripping apps on the Mac – 

HandBrake (handbrake.fr) is free and a 

popular choice. As your personal DVDs 

won’t be encrypted, you won’t need to 

use another tool to bypass protections.

If you want full access to your old 

content, you could install ProShow in 

Windows in a virtualization app such 

as Parallels Desktop; it can exchange 

files with macOS, so you’d be able to 

export the original slides as well as 

completed shows in DVD format.

TECH SUPPORT & TECHSPLANATIONS
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malware tampering with system files, 

provided your Mac is kept updated. 

However, malware can still remove or 

encrypt other files, including apps and 

your documents. Try RansomWhere?, 

which is free from objective-see.com/

products/ransomwhere.html.

Numbers on your Touch Bar
I use an AZeRTY layout keyboard 

on my 2016 MacBook Pro, which 

requires the ß key to be used for 

numbers. Could I put those numbers 

in my Touch Bar instead?

You can’t yet customize the Touch 

Bar globally: settings are intended to 

be app-specific. Two pop-ups in the 

Keyboard tab of the Keyboard pane 

control its general behavior. The upper 

of those can be set to Expanded 

Control Strip, but can’t include 

numeric keys in the way that you want. 

The lower pop-up doesn’t provide 

helpful options for this scenario either.

In apps that support customization, 

you could use the Customize Touch 

Bar command in the View menu to 

make your own custom layout, but 

that doesn’t offer numeric keys. 

Some third-party apps now support 

My MacBook Pro (Mid 

2015) backs up to a 

Time Capsule. Recently, 

it started warning me 

about once a week 

that backups have 

verification problems, 

and informs me that 

it must create a new 

backup. It then wipes 

all my old backups and 

starts again. how can 

I stop this?

Your Time Capsule 

is detecting that its 

previous backups are 

corrupted beyond repair, 

so it must trash them and 

start afresh.

If this occurs once, it’s 

worrying, and when it  

happens repeatedly 

there must be something 

seriously wrong with 

your Time Capsule.

ensure its firmware is 

fully up to date by 

opening AirPort Utility 

and inspecting the Time 

Capsule there. Click any 

red badge next to it there 

for details, update as 

needed, then initialize it 

from scratch.

If, after that, your Time 

Capsule repeats this 

behavior, it shows that 

something is corrupting 

the hard disk in it, or that 

the drive is sick and 

failing – which is a matter 

for Apple Support, or a 

Genius Bar. If it’s older 

than three years, you 

may need to replace it.

> Forgetful Time Capsule

The Customize Touch Bar command affects only the app you’re currently using, and doesn’t allow you to add regular number keys.

If your Time Capsule is over 
three years old and keeps 
having to create a new backup, 
it may need to be replaced.

Tech Support & Techsplanations
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>>> the Touch Bar: BetterTouchTool from 

boastr.net might eventually enable 

what you want, but doesn’t at present.

Burning appendable CDs
I use an external Apple Superdrive 

with my 21.5-inch iMac (late 2012) 

to make Cds and dVds. Upgrading 

to el Capitan removed the feature to 

make them in disk Utility, and now 

I cannot make a disk appendable: 

Finder’s Burn command closes the 

disc so that no more can be written 

to it. Is it still possible to make a Cd 

which is appendable?

This facility still exists in both Sierra 

and El Capitan. However, it’s now only 

accessible using commands in 

Terminal, or with third-party software. 

If you don’t feel like messing around 

at the command line, one of the most 

capable suites for working with optical 

discs is Toast Titanium (roxio.com), 

which can make audio CDs, DVDs, and 

more. There’s a range of cheaper or 

free tools in the App Store, too.

To do it yourself in Terminal, first 

use Disk Utility to create an image of 

the optical disc: assemble its contents 

in a folder, create a new image from 

way to get rid of them is to open Disk 

Utility, select only that volume, and 

erase it. If you have other files there 

and can’t do that, you’ll need to resort 

to the command line in Terminal.

First, check that Time Machine isn’t 

backing up to that location. Type 

tmutil listbackups in Terminal – it 

should list the location of all the 

backups on Time Machine’s drive, but 

not those which you want to remove.

Next, work out the path to that old 

Backups.backupdb folder; for example, 

if it’s on a volume named Old Backups, 

the full path will be /Volumes/Old 

Backups/Backups.backupdb/.

The command which you’ll then 

need in order to remove all those old 

backups will be something like sudo 

tmutil delete "/Volumes/Old Backups/

Backups.backupdb/"

Finally, you’ll need to authenticate 

with an admin user’s password.

Fastest startup for a mini
My Mac mini (late 2014) starts up 

from an external 256GB SSd, and 

I manually transfer documents to its 

1TB hard disk when I need to. Would 

my mini start up more quickly from 

that, and set its Image Format to 

“DVD/CD master,” without encryption. 

Place that master, for example named 

MACDOCUMENTS.cdr, on your desktop, 

insert your blank CD, then in Terminal 

type the following command: 

hdiutil burn ~/Desktop/MACDOCUMe 

NTS.cdr -noforceclose

Trashing old backups
I’ve installed a new, larger external 

hard disk and have started using it 

as a new Time Machine backup. 

On a separate volume on that disk, 

I have an old “Backups.backupdb” 

folder containing some old backups, 

which I want to delete. When I drag 

it to the Trash, I cannot empty it 

because of error -8072. how can 

I get rid of those backups?

Old backups like these present 

a problem when you want to get rid 

of them because of their permissions, 

and the fact that they contain tens or 

hundreds of thousands of hard links, 

which Time Machine uses to make 

each backup look like a complete 

image of your disk.

If you’ve nothing else on that 

partition (volume), then the simplest 

You can delete 
backed-up items 
in Time Machine: 
select a file and 
click the cog 
for options.

>>>Ask
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eMAIl: letters@maclife.com 
FACeBOOk: facebook.com/maclife  TWITTeR: twitter.com/maclifeShARe WITh US!

I normally take the SdXC 

card out of my camera, 

put it into an Integral 

card reader, and plug that 

into a USB port. This no 

longer works, and I can’t 

read the card on my iMac 

or MacBook. What’s up?

Try a different card, in 

case that one has become 

corrupted. If that doesn’t 

work either, your reader 

may have bitten the dust.

Many Macs have integral 

card slots which save you 

the trouble of using 

another peripheral. Older 

iMacs with optical drives 

have their slot close to 

that drive. Newer models 

without optical drives 

position the slot on the 

back, by the USB ports. 

Insert the card the 

right way round, with 

the connectors going 

in first.

Once you’ve 

downloaded all the 

images from the 

card, reformat it. 

Insert the card into 

the camera, and use 

the camera’s menu 

system to format it. 

Formatting cards in 

your Mac isn’t a good 

idea, as it doesn’t 

understand the specific 

folders and other 

requirements expected 

by your camera.

Finally, always 

remember to eject the 

card properly before 

removing it from your 

Mac, either from an 

integral slot or an 

external reader. Not only 

will macOS complain if 

you don’t, but it can 

result in damage to the 

data on the card – even if 

it doesn’t look like data 

is currently being written.

> Card reader folded

a Fusion drive, and would that be 

better connected via Thunderbolt, 

rather than USB 3?

Your fastest option should be to 

boot from an internal SSD. The 

performance of external drives is 

largely dependent on the chipset in 

the enclosure, and less on the 

theoretical maximum performance of 

the bus used to connect the drive. This 

is particularly true for Thunderbolt 

and USB 3. External Thunderbolt 

enclosures are expensive and few, 

if any, significantly out-perform much 

cheaper USB 3 enclosures.

Fusion Drives are a great way 

of getting a large combined capacity at 

a reasonable cost, delivering SSD-class 

performance for the most-used files, 

which usually includes macOS and 

your favorite apps. However they do 

impose some overhead above that 

of just using an SSD. Much of the time, 

a Fusion Drive should deliver near-SSD 

performance for only slightly greater 

cost than a hard disk.

If you can lead a disciplined life 

using separate SSD and hard drives, 

as you have been doing, and have laid 

out the contents of the SSD and hard 

disk optimally, that’s still likely to give 

you a slight edge in performance and 

the time taken to start up. A Fusion 

Drive should make fuller use of the 

SSD, though.

There’s the added complication 

that building your own Fusion Drive 

is currently not officially supported by 

Apple. Some people who’ve done this 

experienced problems when upgrading 

to Sierra. Sticking to a straight SSD 

should be most compatible with 

anything that macOS 10.13 changes 

later in the year – at least until it’s had 

time to settle in and those intrepid 

pioneers have figured out whether 

home-brewed Fusion Drives are a 

practical possibility with it.

Many modern Macs have a built-in 
SDXC card reader, although the slot’s 
purpose isn’t always obvious.

You should get the very fastest 
startup times and best 
performance from an SSD by 
fitting it inside your Mac mini.

Tech Support & Techsplanations

 maclife.com  SeP 2017   79



Record with GarageBand
Get into the groove and record a song with Apple’s free music-making app

REQUIRES
GarageBand,  

OS X 10.11 or later

yoU wIll lEaRn
How to use loops, 

play virtual instruments, 
and record your voice  

or a guitar

IT wIll TaKE
30 minutes

How to Build your first track

Start a project
Download GarageBand for free from 

the Mac App Store, or open it from your Mac’s 

Applications folder if it came preinstalled. 

In the app’s opening window you’ll see a 

number of project templates to choose from.

Add a track
Double-click on the Empty Project 

option to start a brand new project. Next, you 

are prompted to set the type of your first track. 

For this example, choose Software Instrument 

by selecting that option, then click Create.

As pARt of the iLife family, 
GarageBand used to paid-for, 
and given away with all new 
Macs. Recently, Apple made 

it, along with iWork and iMovie, free for 
all Mac users running recent operating 
system versions, regardless of whether 
you’ve just bought new hardware. 
In GarageBand’s case you only need a 
Mac running OS X El Capitan or later.

That’s great news as the app is more 
powerful than you might expect a free 
one to be. Sharing much of its underlying 
technology with Apple’s more advanced 
Logic Pro X, it puts a friendly face on 
music-making tools, and shouldn’t be 
daunting even if you’re a beginner. 

It comes with a lot of premade loops, 
instruments, and effects, and building up 
your first track is surprisingly simple. 
Best of all, you don’t necessarily need any 
extra equipment to start making music – 
with just your Mac and this app, you can 
write tunes right now! Hollin Jones

HOW TO DO ANYTHING ON YOUR MAC, iPHONE & iPAD

CREATE
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Find a loop
You’ll probably want to start with some 

kind of a beat, so open the loops library by 

clicking the Apple Loops button at the top 

right of the window. To filter the list of loops, 

click the Loop Pack pop-up and pick a category.

Add to project
Click a loop to hear it. To place a loop 

into a project, drag it from the library and drop 

it on a track in the centre. Its tempo will adjust 

to match the project. To change the project’s 

tempo, double-click the tempo box at the top.

Quick look GarageBand’s interface

InSTRUmEnT 
pRESETS
All your instruments can 
be loaded from here by 
choosing a category, then 
an instrument preset. 

loop lIbRaRy
You can sort loops using 
tags and names, download 
just those you want, and 
drag them into a project 
to create backing tracks.

EdIToRS
MIDI and audio can be 
edited. This means 
sounds you’ve recorded 
as well as content from 
GarageBand’s library. 

TRacK lIST
Build up layers of loops, 
instruments, and audio 
recordings, then use the 
sliders here to adjust the 
level of each one.

aRRangEmEnT
Copy, paste, and arrange 
clips on the timeline. Drag 
the ends of loops to make 
them longer. Snap clips to 
ensure correct timing. 

 
gEnIUS TIp

GarageBand’s content 
library is over 20GB in 
size. To save disk space, 
just download the sounds 
or instruments you want, 
using the small arrows 
next to their names. 

How to do anything on your Mac, iPhone & iPad
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Add a real recording
To add a real recording, choose Track 

> New Track, select the option to record using 

a microphone, and click Create. Connect some 

headphones and a good USB mic. With this 

track selected, press Record in the toolbar.

Share or export
When you’re finished, choose an item 

from the Share menu. You can send your music 

to iTunes, SoundCloud, email or AirDrop it, or 

export a file. Export as high quality AAC for a 

smaller file, or AIFF for an uncompressed file.

Make the loop longer
Drag the right-hand edge of the loop 

to the right to add more copies of the loop. 

Then find another loop, say a bass or guitar, 

and drag that to a new track, extending 

it to cover as many bars as you like, too.

Build more parts
Keep adding loops, recordings, and 

instrument parts until you are happy. The clips 

on the timeline can be cut, moved, or deleted 

to help build your arrangement. Select a track 

then a new instrument to try different sounds. 

Mix the song
Press the Smart Controls button near 

the top left of the window to see controls for 

the effects and instruments in the selected 

track. Use the level faders on a track to change 

its volume and refine the mix of your tracks. 

Add an instrument
Now choose the instrument track – 

we’ve picked an electric piano, but you can use 

any you like from the library on the left. Pick 

Window > Show Musical Typing to see how to 

play the instrument using your Mac’s keyboard. 

 
gEnIUS TIp

In the app’s preferences, 
you can change the device 
your Mac uses to send and 

receive sound. Use this 
option with a dedicated 
audio interface to make 

higher quality recordings.

>>>Create
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Pages is caPable of much 
more than bashing out the odd 
letter. You can use it to create 
eye-popping ads, fab flyers, 

nifty newsletters, mouthwatering menus, 
and pretty much any other kind of 
document you can imagine. You can even 
use it to create ebooks, and to collaborate 
on documents via iCloud. We’ve used it 
to write books, create album covers, and 
design brochures, and we’re constantly 
amazed by how easy it is to use and how 
great the results are.

You can collaborate with others in real 
time with Pages on Mac, iPad, iPhone, and 
iCloud.com, easily replace fonts through 
an entire document, import and export  
Rich Text Format (RTF) files, and make 
use of tabbed windows to work across 
multiple documents without cluttering 
your desktop with extra windows. 

This kind of stuff wouldn’t be helpful 
if Pages didn’t talk to other apps, but it 
does. You can export your masterpiece as 
a PDF, Word, or an ePub document, as 

Publish like a pro with Pages
Apple’s publishing app is free, fun, and surprisingly powerful

well as RTF and plain text files, and you 
can send documents by email, Messages, 
or AirDrop, or add them to Notes. And 
images and movies you embed can be 
optimized for playback on iOS devices.

In this tutorial, we’ll use a simple 
brochure to explore some of Pages’ design 
tools. We’ll use Instant Alpha to remove 
the background colors of images, and 
explore the use of masks to control how 
images display in your document and how 
text flows around them. We’ll also look at 
the various formatting options for images 
and text, and how you can stack different 
elements on the page.

One thing we won’t be doing is using 
Pages’ media browser to organize and add 
images, as it can be a very slow process. 
It’s a minor flaw in an otherwise excellent 
app, and easily worked around. We’ve 
found that organizing our images as 
albums in Photos, and dragging from 
there into Pages, is much faster. If you’d 
rather not use Photos you can drag from a 
Finder window instead. gary Marshall

REQUIRES
Pages, and some photos 
to use in your document

yoU wIll lEaRn
 How to create stunning 

brochures in Pages

IT wIll TaKE
25 minutes

how to Design a brochure in Pages

Pick a design
Pages’ templates include the 

usual kinds of letters and flyers found in 

a word processor, but you can also create 

impressive brochures and other things 

you’d expect from a desktop publishing 

app. We’ll use the Museum Brochure.

Thumbs up
This template isn’t a one-pager: 

it’s designed to print on both sides. If you 

click the View button at the top left of 

the window and choose Show Page 

Thumbnails, you can move between the 

two sides with a click.

Drag images
Pages’ built-in media browser can 

be painfully slow. To add images without 

having to wait around, drag them from 

Photos (or Finder) onto the relevant spot 

on your document. Here we’re replacing 

the center image.

>>>Create
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Resize or move
As you might expect, you can 

adjust the space allocated to an image 

by dragging the handles on its edges 

and corners. If you move an image, 

temporary guides appear to help you 

align it with other objects on the page.

Kill more colors
By default, Instant Alpha only 

removes one color, but if you drag across 

a range of colors you’ll make all those 

the pointer passes over transparent, too. 

Take care: if you overdo it you’ll find that 

your images start to look really weird.

Line it up
Choose View > Zoom > Fit Page 

to see how your page looks in full and 

check that the design works. That large 

picture on our page doesn’t look good: 

it should really fit into the first column, 

or sit behind the entire page.

edit the mask
If you find that the picture is too 

big for the space allowed, choose Format 

> Image > Edit Mask. You can now drag 

the image around within its frame, or 

resize it so that it looks just right on your 

page, without being cut off or too big.

Put it back
If you want an image to appear 

behind everything else, click the Format 

inspector’s Arrange tab. Sometimes, 

though, you’ll see something like the 

above: our image is behind another 

image that has a solid background.

Add your own text
Replacing text in a Pages template 

couldn’t be simpler: just select the text 

you want to replace, then type or paste 

the new text. Use the Format inspector’s 

Text tab to adjust fonts, sizes, colors and 

spacing to make things just so.

Instant Alpha again
We need to use Instant Alpha to 

remove the background color from the 

foreground image. You may find this 

causes text to appear around it. To stop 

that, select the image, then experiment 

with the Arrange tab’s Text Wrap options.

Have some fun
Pages really rewards exploration: 

the good old “What does this button do?” 

approach often uncovers great features. 

Here we’ve experimented with 

transparency and masks to run a big 

image of a Mac across multiple columns.

Kill the background
If your image has a background 

color, you can remove it: open the Format 

inspector (top right), then click the Image 

tab followed by Instant Alpha. If you now 

click the background of your image, it 

appears in cyan to indicate transparency.
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Edit shortcuts
In the Actions tab, click the cog in the 

control under Keyboard, and set the shortcut 

to ç+†. Set the Backward option below to 

ß+ç+†. When it’s active, Witch will replace 

macOS’s built-in app switcher.

Use the switcher
Open some Safari windows and then 

hide the app (ç+h). Bring up Witch (ç+†), 

navigate to Safari and, with your thumb still 

holding ç, press the æ key. Your open Safari 

windows will be displayed in a list.

Witch’s slogan is “ç-Tab 
Everything”. Initially, the app 
resembles the standard macOS 
app switcher, but dig deeper 

and you rapidly realise Witch is akin to 
a “pro” take on Apple’s implementation.

With Witch’s switcher active, you 
can drill down into apps to access their 
windows by name – more efficient than 
Exposé – or even by tab. Not sure what 
you’ve got open, but recall a window’s 
title? Just use Witch’s search function 
to type and rapidly filter open windows 
in real time, much like triggering a 
Spotlight search.

There’s a ton more more to discover: 
visual customization, menu bar access, 
multiple switchers, and more. The bulk 
of it is covered in some form in our 
walkthrough. Before the first 

Power up your app switcher
Replace macOS’s app switcher with the superb Witch

step, we assume you’ve installed Witch, 
opened it in System Preferences, and 
clicked Enable Witch.

You can download a free trial of Witch 
from manytricks.com/witch. After 50 
uses, Witch will occasionally suggest you 
buy it, which will cost you $14.  
craig grannell

REQUIRES
OS X 10.10 or later, 

Witch 4 or later

yoU wIll lEaRn
How to replace and go 

beyond macOS’s app 
switcher with Witch

IT wIll TaKE
10 minutes

hoW to Make the most of Witch

use Witch’s search function to tyPe 
and raPidly filter oPen WindoWs

 
GEnIUS TIp

In the Appearance tab, 
you can adjust the look 

of Witch. Themes can be 
saved in the Presets menu, 

which comes with several 
predefined alternatives.

>>>Create
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preview and select
To bring a window to the front, select 

it and release ç or press ®. For non-hidden 

windows, selected items can be previewed by 

pressing the space bar. Alternatively, return to 

the app switcher by pressing “.

Use the menu bar
Back in System Preferences, you’ll see a 

second switcher is set to show in the menu bar. 

Change its sort order to App Name > Window 

Title. Now click the menu bar icon to see an 

alphabetized list of apps and windows.

Define some shortcuts
We already use ç-tabbing for Witch‘s 

main switcher, so set the new switcher’s 

two shortcuts to å+† and ß+å+† for, 

respectively, forward and backward. Use 

the shortcut to bring up your new switcher.

Filter your windows
If you’ve scads of windows open and 

don’t feel like going through them all, open 

Witch and with ç held, press s to search. 

Start typing to see only item names containing 

your search terms. Again, ® selects one.

Create a new switcher
Click + to create a new switcher. 

This one will be specifically for listing open 

windows. Set the top-left menu to Cycle 

Windows, “Sort by” to App Name > Window 

Title, and the orientation direction to down.

Adjust how tabs display
In Safari, add tabs to a window. In Witch, 

a window with tabs has > next to its title. Use 

the ‘ key to drill down. Or adjust the Mode 

menu’s setting to treat tabs as windows, and 

they’ll then be listed together.

 
JaRGon bUSTER

The app switcher has 
long been a core Mac 
component. Triggered 
using ç+† it enables 
you to see which apps are 
open and switch to them. 
But Witch does more.

 
GEnIUS TIp

In Witch’s Advanced tab, 
uncheck “Releasing all 
modifier keys” and Witch 
will remain active without 
you having to hold ç.  
(œ closes it.)
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Quick Look The toolbar and the tab bar

Reading List
Pages you add to this are 

saved on your Mac, so you can 

read them without being online. 

To add one, put the pointer over 

the search bar and click the + , or 

use ß+ç+D. To see the list, pick 

View > Show Reading List Sidebar.

Favorites
The best way to add the 

current page to the favorites that 

appear when you place the focus 

in the search bar is to drag and 

drop the icon from there to the 

grid position where you want it.

Bookmarks
To add a bookmark for a 

page to any folder, put the pointer 

over the search field and ≈-click 

on the + on the left (or click it with 

two fingers on a trackpad), move 

the pointer down the folder list, 

then let go over the desired folder.

Other apps
With a page open, click in 

the search bar and then drag the 

icon that appears to Finder to save 

a hyperlink as a file, or into a doc in 

apps such as TextEdit and Notes – 

handy for consolidating research.

> Add current pAge to…

Save the current page or send it elsewhere

cheat sheet: Safari
Discover features that give you a smoother experience on the web

on the SurfAce, your Mac’s 
built-in web browser looks 
much like any other. It has a 
dual-purpose bar for entering 

the address of a website or page, or terms 
you want to search for, and a tab bar for 
all the pages you have open. Yet it packs 
in many useful tricks for easier browsing.

Before we move on to those, let’s talk 
about a couple of shortcuts that are really 
helpful. First, rather than reaching for 
your mouse or trackpad to click in the 
search bar, press ç+l instead. This 
moves the input focus to the bar.

Second, as you’ll see on the opposite 
page, typing in the search field displays 
various kinds of suggestions. Quickly 
move down them a category at a time by 
using ç+æ. In fact, this also works 
in the results presented by macOS’s 
Spotlight feature. ALAn Stonebridge

Quick History
With the pointer over the 
Back or Forward button, 
hold down your mouse or 
trackpad’s button for a 
history of pages visited 
in the current tab, before 
or after the page you’re 
currently looking at.

Pin tabs oPen
Drag a tab to the left end 
of the bar to pin it there; 
it’ll show the site’s icon. 
Pinned tabs appear in all 
Safari windows bar private 
ones, and work great with 
key combos for switching 
tabs (see opposite).

reload Page
Click this to reload a 
page, or hold down on it 
for options to reload 
without content blockers 
(some sites block you if 
one’s detected), or with 
plugins active that are 
ordinarily disabled.

tHe tab bar
Unlike some browsers, 
Safari’s tabs show page 
titles but not site icons. 
For a graphical overview 
of all open pages, though, 
press this or ß+ç+\; 
see opposite page for a 
fast trackpad alternative.

sHare oPtions
The options behind this 
button are replicated in 
File > Share, enabling you 
to set key combos to 
quickly post to Facebook, 
say. Do that in  > 
System Prefs > Keyboard > 
Shortcuts > App Shortcuts.

>>>Create
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Quick Look Understand the search field’s suggestions

Keyboard
To go back or forward 

in a tab’s history, hold ç and 

press a square bracket key. 

To move along the tab bar, 

add ß. Use ç and a digit 

(1 to 9) to jump to a tab. Set 

up combos for menu items in  

 > System Prefs > Keyboard 

> Shortcuts > App Shortcuts.

> nAvigAtion ShortcutS

Discover quick ways to get around using popular input devices

Trackpad
Swipe two fingers left 

or right to go back or forward. 

With the pointer over a page 

element, double-tap two 

fingers to zoom in on it, or 

spread apart/pinch together 

to zoom arbitrarily. When fully 

zoomed out, pinch again for 

an overview of all open tabs.

Magic Mouse
Horizontal swipes 

of two fingers jump back 

and forward through a tab’s 

history. Magic Mouse doesn’t 

offer arbitrary zooming, but 

a two-finger double-tap on it 

zooms in or out to whatever’s 

under the pointer, just as it 

does on a trackpad.

Third-party 
mice

Check whether your mouse’s 

maker provides software for 

tailoring what the various 

buttons do. In some cases 

you can even tailor actions 

to do different things 

according to what app you’re 

using at a given moment.

searcH engine
As you type in the search bar, 
Safari shows a mix of suggestions, 
including those from whatever 
search engine you’ve chosen in 
Safari > Preferences > Search.

safari suggestions
Safari makes suggestions it thinks 
are relevant, such as stock prices, 
iTunes music, and Wikipedia 
articles. Also, try “Weather” or 
“Map” followed by a place name.

 
Quick site searcH
Safari remembers sites’ search 
engines that you use. Later, type 
a site’s name and some words; 
you’ll see a suggestion to submit 
those terms directly to the site.

sHow favorites
If new windows or tabs are set to 
show your favorite sites (in Safari 
> Preferences > General), you can 
opt to not have them appear in 
the search bar’s suggestions.

FoUND 
THIS USEFUL?

ShAre IT 
WITH oTHERS

bit.ly/ml132cs
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Sign up
To try the public beta versions 

of any Apple operating system, first go 

to beta.apple.com and click the button 

labelled “Sign Up” – scroll down if you 

can’t see it. Enter your Apple ID’s 

details and click the “Sign In” button.

Read the terms
Read the beta program’s terms 

and conditions. The fifth item is very 

important, as it forbids sharing of info 

and screens with non-participants, at 

least of things Apple itself hasn’t 

disclosed to the general public.

Accept agreement
Click Accept at the bottom right 

of the page. Next, you’ll see a page 

containing guides for installing the 

various beta OSes; before you install 

High Sierra, read the walkthroughs 

opposite for our recommendations.

Apple hAs mAde public beta 
versions of this year’s system 
upgrades available for you to 
try. Why would you want to 

run a version that’s likely to contain a few 
bugs? Aside from being helpful to Apple, 
you might want to check whether any of 
the apps or accessories you depend upon 
have any showstopping incompatibilities. 
It’s wise to do that as early as possible if 
you plan to buy a new device that’ll come 
with one of these systems preinstalled.

The method of trying out High Sierra 
we present on these two pages makes it 
easy to switch back and forth between 
it and your working system.

Things are more involved on iOS 
in particular, mostly due to the 
time it takes to download the latest 
non-beta version, erase your device 
to install it, and restore a backup.

The key thing to remember to do 
on macOS and iOS is to make a full 
backup of your device immediately 
before installing. Backups made on 
iOS 11 will be worthless to you if 
you later roll back to iOS 10. 

Get iOs 11, high sierra, and tvOs
Try out the public beta versions of Apple’s latest operating systems today

And  on macOS, Apple’s advised method 
is to back up using Time Machine. 
However, restoring your entire Mac from 
Time Machine’s backups is a disruptive 
and slow process, so we recommend 
another route that requires a second 
drive; it takes longer upfront, but it saves 
you stress if you run into a big problem.

In order to try any (or all) of the public 
betas, start by following the three steps 
below to sign up for Apple’s public beta 
program. Should you want to roll back to 
your non-beta system, see Apple’s guides 
at bit.ly/betarstr. AlAn stOnebridGe

REQUIRES
A Mac that meets macOS 

Sierra’s requirements  
(see bit.ly/sierrareqs).  

See following pages  
for iOS 11 and tvOS 

system requirements.

yoU wIll lEaRn
How to sign up for and 

install Apple’s public betas 
of macOS, iOS and tvOS.

IT wIll TaKE
At least an hour

hOw tO Sign up for the public beta program

>>>Create
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enroll your Mac
With your Mac started up from 

the clone, sign in at beta.apple.com, 

click “macOS”, and click “enroll your 

Mac” under Get Started. On the next 

page, download and install the public 

beta access utility.

Make a backup
Instead of Time Machine, we’ll 

use a different tool to save time if you 

want to roll back, yet still test your full 

setup with High Sierra. Connect a spare 

drive and erase it (not just its partition) 

with a GUID scheme in Disk Utility.

Download installer
Close the beta access utility 

installer and the App Store will open 

to a High Sierra beta page. Click the 

button on its left side to download the 

actual installer for the beta; it’s more 

than 5GB large, so it may take a while.

prepare for cloning
Download SuperDuper (shirt-

pocket.com) to clone your startup disk 

to the second drive. Set the app’s Copy 

pop-up menu to your startup disk, 

its “to” pop-up to your external drive, 

and “using” to “Backup – all files.”

Install the beta
When the installer opens, run 

through its steps, then wait. Just make 

sure the “High Sierra” volume is set as 

the destination. You can opt out of the 

new Apple File System, but doing so 

defeats a reason to try the beta.

Start cloning
Click Options. Set “During copy” 

to “Erase <volume>, then copy files…” 

and then Click OK > Copy Now > Copy. 

Once cloning’s done, rename the copy 

“High Sierra,” make it your startup disk 

in System Prefs, and restart your Mac.

> switch bAck

Return to your previous system in seconds

Once the beta is installed, you’ll continue to receive updates to it right through to 

the general public release. If you’ve followed our method of trying out the beta on 

a second drive, either as a clean installation or over the top of a clone of your 

working system, you can switch back to your previous version of macOS or OS X 

by choosing it in System Preferences’ Startup Disk pane. But if you used Apple’s 

method of making a Time Machine backup, you‘ll need to follow Apple’s guide for 

Sierra at bit.ly/rstrtimemac or the one for your system at bit.ly/rstroldersys.

hOw tO Install the macOS High Sierra beta

hOw tO Prepare your Mac
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instAllinG the public beta 
of iOS 11 is straightforward, 
though it’s best if you use a 
device you don’t depend on 

from day to day – say, to check your bank 
account and pay your bills.

You can restore your device to iOS 10 
if you want – or at least you can for a short 
time after the final public release of iOS 11 
drops, though Apple doesn’t say exactly 
when that will be.

If you decide iOS 11 isn’t for you, make 
sure you roll back as soon as you can spare 
the time to do so. Note that the process 
takes longer to complete than simply 
telling your Mac to switch from starting 
up High Sierra from one partition to using 
your previous system on another.

As always with a big software update, 
the first thing you should do is make a 
backup of your device. On iOS, you might 
already be doing this using one of two 
methods: using iOS’s iCloud Backup 
feature, which backs up automatically 
when your device is locked, on Wi-Fi, and 
connected to a power source; or using the 

try out the iOs 11 public beta
Take the new Control Center, better iPad multitasking, and more for a spin

device backup capability of iTunes on your 
Mac, located on a device’s summary page. 
AlAn stOnebridGe

REQUIRES
iPhone 5s, SE, 6, 6s, or 7, 

iPad mini 2 or later,  
iPad Air or later,  

iPad Pro (any model), 
or an iPod touch 
(6th generation) 

yoU wIll lEaRn
How to prepare your 

device and data, and then 
install the iOS 11 beta.

IT wIll TaKE
At least an hour

enroll your device
Go to beta.apple.com on the 

device on which you want to install the 

iOS 11 public beta, click iOS near the top 

of the page. Scroll down to the Get 

Started heading and then click “enroll 

your iOS device” in the text below it.

Back up to iCloud…
You’ll be reminded to back up. 

If you use iCloud Backup, open Settings 

and tap the row for your Apple ID at the 

top, then iCloud > iCloud Backup. Tap 

Back Up Now so iCloud records your 

device’s latest state, and let it complete.

…or iTunes on a Mac
To back up using iTunes on your 

Mac, follow the steps for preparing a 

device for a beta software update at  

bit.ly/prepiosbeta – do not skip step 5, 

as you’ll need an archived backup if you 

want the option to roll back to iOS 10.

hOw tO Install the iOS 11 public beta

>>>Create
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prepare Apple TV
In Settings > Accounts, sign in to 

iCloud, iTunes and App Store, or Game 

Center using your beta program Apple ID. 

Receive and install
In the same place, if Automatically 

Update is switched on, your Apple TV 

will receive public betas as part of that. 

Or, go to Settings > System > Software 

Updates > Update Software to check for 

and install the latest version right away.

Opt in to betas
Go back to the top of Settings, 

then to System > Software Update and 

switch on Get Public Beta Updates.

the lAtest tvOS is the easiest 
to install of all Apple’s public 
betas. There are no backups 
to make and no profiles to 

install; you only need the Apple ID you 
registered with the Apple Beta Software 
Program. See the steps to the right.

Rather than supplying feedback from 
your Apple TV, which would be tedious 
to enter using its Siri Remote, Apple 
expects you’ll also be running the iOS 11 
public beta. Consequently, if you have 
bugs to report or suggestions to make 
about the tvOS beta, open Feedback 
Assistant on iOS 11 – you’ll find it on the 
Home screen, by entering at least some of 
its name in Spotlight, or by saying “Open 
Feedback Assistant” to Siri. Tap the new 
message icon, then choose your Apple TV 
under “Feedback for,” or tap Other 
Devices if you don’t see it listed there.

To restore your Apple TV to a non-beta 
version of tvOS, you’ll need a USB-C cable 
with the corresponding connector for your 
Mac at the other end. You’ll find steps to 
roll back at bit.ly/rollbackbeta.

put the tvOs beta on your Apple tV
Try out interface tweaks and other improvements to the little black box

REQUIRES
Apple TV (4th generation)

yoU wIll lEaRn
How to receive public 
beta versions of tvOS.

IT wIll TaKE
15 minutes, depending on 
your internet connection

Download profile
Under the text of the second step 

on the web page, click the “Download 

profile” button. You’ll be taken to the 

Settings app and be shown a summary of 

the profile; basically, it tells your device 

to check for and receive beta updates.

Install and restart
Tap Install on the summary and 

read the reminder that what your device 

will receive is pre-release software. Tap 

Install again, then a third time on the 

confirmation dialog. When prompted to 

restart your iPad, tap Restart.

Get the beta itself
When your device restarts, go to 

Settings > General > Software Update and 

momentarily you’ll be told that your 

device is eligible to receive the iOS 11 

public beta. Tap Download and Install, 

then follow the usual on-screen steps.
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A clean page
Open the journal in which you 

want to import a photo and tap the 

arrow at the right of the screen to 

move to a new page. Tap the Tools 

palette at the top of the screen, next 

to the color picker, to see its menu.

Take or choose
In the Tools palette, tap Camera 

if you want to take a new picture right 

now, or tap Import Image to add an 

existing one. Once you’ve authorized 

access to your photo library, you’ll see 

a list of albums appear in the menu.

Select your pic
Navigate to the photo you want 

to import and then tap it. It will appear 

on the page. You can now use two 

fingers to resize it by pinching in or 

out, or twist to rotate it. Use one finger 

to drag it into position on the page.

Created to be a digital 
version of the real-world 
notebooks, sketchbooks, and 
planners, Moleskine Journal 

allows you to write and draw on your iOS 
device in a virtual Moleskine. You can 
also import photos and sync notes with 
Evernote, or back them up to Dropbox.

If you choose to type rather than write 
by hand, Moleskine Journal supports the 
full range of iOS fonts, with the ability to 
resize them on the page. If you would 
rather work by hand, you can use either 
your finger or a stylus, including the 
Apple Pencil. You can choose from a 
paintbrush, pencil, pen, or highlighter, 
and the color picker gives you full control 
over the hue of what you write or draw. 

There are two modes for writing. 
Productivity mode allows you to type with 
the on-screen keyboard, which includes 
controls for choosing a font, setting the 
size of the text, and styling it as bold, 
italics, underline, strikethrough, or 
highlighted. You can also set the color 
of the text here, as well as indent it or 
choose a bulleted or numbered list. 

Start keeping a diary 
With Moleskine Journal, it’s simple to start recording your life

Creativity mode is designed for creating 
shorter, prettier text and allows for larger, 
fancier typefaces.

Alternatively, you can draw or write on 
the screen using your finger or a stylus. 
Just choose your instrument (pencil, pen, 
highlighter, or brush) and start drawing. 
There’s also a scissors tool that acts like 
the lasso selection tool in Photoshop, 
enabling you to draw around something 
and cut or copy it to paste elsewhere.

You can swap between Productivity and 
Creativity modes whenever you like, and 
can set the paper style (plain, lined, 
squared, weekly planner, or storyboard) 
from the Tools palette. One of the real-
world Moleskine notebook’s best-loved 
features is the pocket tucked inside the 
back cover, and that’s also here in the 
digital version, enabling you to store 
snippets of text and images.

Fortunately, unlike the real thing the 
digital journal has multiple levels of undo. 
So if you write or draw something you 
don’t like, just tap the back arrow in the 
toolbar to get rid of it – without ruining 
your Moleskine. Kenny HempHill

REQUIRES
Moleskine Journal, 

iOS 8.1 or later

yoU wIll lEaRn
How to use Moleskine 

Journal’s different modes 
to add content and sync 

with Evernote

IT wIll TaKE
30 minutes

How to Import photos

>>>Create
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Add an image
Tap the top right of the screen 

to open your journal’s pocket. To add 

an image from your photo library to 

the pocket, tap the picture icon at the 

bottom of the screen. To take a new 

one, tap the camera icon.

Sign into evernote
Open the Tools palette and tap 

Settings. Turn on Evernote Login and, 

when the dialog pops up, type your 

Evernote account’s details into the 

username and password boxes. 

Tap Sign In to continue.

Add text
To add “creativity text” or an 

image from the main notebook to the 

pocket, tap the text or image in your 

journal and choose Pocket. To delete 

an item from the pocket, tap the pencil 

icon, the item, and then the trashcan.

Authorize evernote
On the next window, choose 

how long you want to allow Moleskine 

to access your Evernote account and 

tap Authorize. Now go back to the 

Tools tab and tap Export. Tap Evernote 

to send your notebook to that service.

empty the pocket
To place an item from the 

pocket onto a notebook page, hold a 

finger on it, then drag it onto the page. 

Resize it and drag it into position, and 

double-tap it to set it in place. To move 

it again, tap it, then Lift, and drag it.

export to evernote
You’ll see a list of your Evernote 

notebooks in the Tools window. Find 

the notebook you want to export to 

and tap it. Tap “Left page,” “Right 

page,” or “Both pages” to tell 

Moleskine Journal what to export.

> expanding your optionS 

Add more notebook types with in-app purchases 

Moleskine Journal has three options for in-app purchases. They cost $2.99 each 

and are designed to replicate the Passion Journals the company produces for 

its real-life notebooks. The three digital versions currently available are a wine 

journal, a recipe journal, and an interactive traveler’s journal. Each has specially 

designed pages for its subject; for example, the wine journal has sections for 

different types of wine plus space for you to record the names of wines and your 

notes. When you buy one, it’s added to the notebooks view in Moleskine Journal.

How to Use the inner pocket

How to Sync with Evernote

How to do anything on your Mac, iPhone & iPad
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Label it
In Photos, tap the Albums icon 

to view albums that gather photos 

automatically using metadata. To 

create a custom album manually, tap 

the + icon. Enter a name for the album 

and then tap Save.

Add photos
You’ll be taken to Moments, 

where you can browse your pictures 

by date. Scroll to a particular Moment 

and tap the photos you want to add to 

your album. Drag with a finger to add 

multiple shots quickly. Tap Done.

View custom album
You’ll now have a custom album 

full of hand-picked photos in the 

Albums section. Tap its icon to view 

its contents. Tap a thumbnail to view 

it full-size and swipe through the 

contents of the album to enjoy them.

In the days of analog film 
cameras we were limited to 
shooting on rolls of film that 
produced a maximum of 36 

photos at a time. Most people would only 
use a handful of rolls of film each year to 
record special events such as holidays, 
weddings, and birthdays.

In these digital days, you’re never 
without a camera thanks to the app 
provided with every iPhone and iPad. 
As well as shooting birthdays, holidays, 
and weddings, you’re likely to document 
ordinary daily activities as a series of clips 
and stills. Unlike our analog ancestors, 
we have thousands of digital photographs 
and video clips to manage and share.  
Fortunately, iOS’s Photos app has all the 
tools you need to take control of your 
ever-growing collection of digital assets. 

Photos uses the analog album model 
to organize digitally sourced shots and 
clips. Analog albums had to be filled 
manually, but Photos uses the metadata 
stored in digital images and video clips 
to help gather related files together 
automatically, in various ways.

Get more from your albums
Organize your shots more effectively with albums in Photos

An image’s metadata can tell Photos 
where and when a shot was taken, and 
what type of shooting mode was used 
(such as time-lapse). If you use your 
iPad’s front-facing camera to snap a shot, 
then Photos presumes you’re taking a 
self-portrait. These will automatically 
be stored in the Selfies album in Photos, 
so you can find all your best poses in 
an instant. If you have set your iPad and 
iPhone to upload to the iCloud Photo 
Library (in Settings > iCloud) then you’ll 
also find Photos has created albums that 
store images taken in Panorama, Time-
lapse, and Burst mode automatically.

Automatic albums are a springboard to 
finding specific types of files fast, though 
you’ll find it more useful to create themed 
albums from scratch. We’ll show you how 
to create albums, add photos to them, and 
even merge multiple albums to simplify 
your collection, if you find yourself with 
too many on the go.

You’ll also learn how to share album-
based content with friends and family so 
that your precious pictures will find their 
audience. GeorGe CaIrns

REQUIRES
Photos

yoU wIll lEaRn
How to create and add 

pictures to an album, 
manage albums, and 
share their contents.

IT wIll TaKE
15 minutes

how to Create a custom album

>>>Create
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Create a slideshow
You can view an album’s 

contents as thumbnails to create a 

slideshow. Tap Slideshow, then Options. 

Choose a theme, such as Origami 

(which adds picture-in-picture and 

motion effects). Tap Play to view it.

Delete an album
You can rearrange your digital 

albums, which is helpful if the Albums 

view gets cluttered. Tap the Edit 

button, then tap the X by an album to 

delete it. The contents of that album 

remain accessible in the Moments view.

Share online
In an album, select the shots 

that you want to share online. Tap the 

Share icon. Select more of the album’s 

content now if you want, then tap the 

icon of where you want to share those 

photos, such as Facebook. Tap Post.

Rearrange albums
While the X is still present, tap 

and drag an album to reorder the list. 

Press Done when you’re happy with the 

arrangement and the X will disappear. 

The rearranged albums are now locked 

into their new positions.

extra share options
As well as sharing photos using 

iOS’s built-in apps, such as Messages 

and Mail, you can tap the More button 

to add third-party apps such as Skype 

as destinations. Turn on the switches 

next to services you want to publish to.

Merge Albums
Open an album, tap Select, then 

tap the photos you want to merge (or 

Select All), then tap Add To. Next, tap 

the album to merge the selected 

photos with. (If you’ve emptied the first 

album, you may want to delete it.)

> share vIa iCloud

Export an album to select family and friends

Go to Settings > iCloud > Photos. Scroll down to iCloud Photo Sharing and turn 

it on, then open Photos and select the pictures that you want to share. Tap the 

Share icon and choose iCloud Photo Sharing. The app will prepare the images.  

In the dialog that appears, type in a comment, then tap Shared Album followed 

by New Shared Album and give it a name. Tap Next. Enter the email addresses 

of the people you want to view your photos. Tap Next, then Post. The album 

appears in Photos’ Shared view on your and your friends’ devices.

how to Share album content

how to Organize albums

How to do anything on your Mac, iPhone & iPad
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>>> Discover dozens 
of iOS 11 tips 

>>> Tutorials for 
macOS High Sierra 

>>> Reviewed: Apple’s 
new 27-inch iMac
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ApplE’s INfINITE lOOp campus isn’t 

open to the public, and even authorized 

visitors are ushered firmly to and from 

the department they’ve been invited to. 

There’s just one area where everyone’s 

always welcome: the Company Store.   

Established in 1993, it predated the 

Apple Store chain and remained for 

years the world’s only official Apple 

store. It was the highlight of my own first 

trip to Cupertino, in the late 1990s: Phil 

Schiller’s press event, which I’d flown 

5,000 miles to attend, was (unusually) 

rather dull, but wandering around Infinite 

Loop with a colleague was exciting – 

even if we were warned off attempting 

entry by the not-so-discreet gaze of 

an Apple cocktail shaker. But the logos 

are uncompromisingly monochrome.

As Infinite Loop’s workforce decamps 

to Apple Park, the Company Store will be 

reborn once more in the site’s visitor 

center – separate, again, from the 

“mothership” where the real work will 

happen. Spread over more than 10,000 

square feet, according to the plans, it’s 

surely going to be worth a visit: if you 

never make it any closer to the inside of 

Apple’s empire, at least you can say you 

got the T-shirt.

security guards. At the Company Store, 

entry seemed almost compulsory, 

though. Modestly sized and blandly 

styled, it felt like a museum gift shop, 

but what mattered was its exclusive 

range of branded merchandise – bags, 

mugs, T-shirts, hats – bearing the coveted 

rainbow-striped logo.

In 2015, unexpectedly, the Company 

Store closed for the summer and 

reopened as a full-blown Apple Store. 

One British visitor on TripAdvisor sniffed 

that the expanded outlet’s “red T-shirt- 

wearing drones” could no longer sell him 

“any of that cool Apple swag.” You can, 

in fact, still buy a $35 Apple pen, a small 

selection of minimalist apparel, or even 
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RANdOM ApplE MEMORy

The Company store
It’s the only part of Apple’s headquarters that isn’t a secret,  

and Adam Banks remembers it fondly
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The late, lamented 
Company Store’s 
enviable merch.
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CHARGE UP BEFORE YOUR BIG NIGHT OUT.
Be the last man standing with the dual charging iWBT400 alarm clock radio. Power up your smart device
and your apple watch while you get ready. With so much power at your disposal make sure your night will
be one for the record books.
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